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バージョンの比較 
以下の表は、各ソフトウェアバージョンの機能や特長の概要を示します。 

 
機能/特長 エッセンシャル 

バージョン 
（フリーウェア） 

プロフェッショナルバージョン 
（試用期間：60 日間 + 30 日間 
（延長を希望された場合） 

サポートされるデータベース： 

Postgre SQLTM X X 

OracleTM  X 

Microsoft SQL ServerTM  X 

サポートされる機器： 

Ecograph RSG20  X 

Ecograph A RSG22  X 

Ecograph C RSG24  X 

Ecograph T RSG30 X X 

Ecograph T RSG35 X X 

Memograph RSG10  X 

Memograph S RSG12  X 

Memograph M RSG40 X X 

Memograph M RSG45 X X 

EngyCal RH33  X 

EngyCal RS33  X 

RA33  X 

Liquiline CM44x  X 

Liquistation CSFxx  X 

Liquiline System CA80xx  X 

サポートされる機能： 

ユーザー管理；LDAP 機能  X 

複数の PC からデータベースへの同時アクセス  X 

1 つのテンプレートで複数の機器のデータを使用  X 

データの自動読出し X X 

データの自動削除 X X 

自動バイナリエクスポート  X X 
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機能/特長 エッセンシャル 
バージョン 

（フリーウェア） 

プロフェッショナルバージョン 
（試用期間：60 日間 + 30 日間 
（延長を希望された場合） 

自動 XLS/CSV エクスポート   X 

自動 PDF 出力  X 

eSight（エネルギー監視用ソフトウェア）用の 
エクスポート 

 X 

ReadWin 2000 データのインポート X X 

瞬時値のオンライン表示（「Live Data（生データ）」）  X 

電子メール通知  X 

更新の検索  X 

TrustSens 校正、自動機能 X X 

デモバージョンをプロフェッショナルバージョンまたはエッセンシャルバージョン（フリーウェア）として使用するに
は、試用期間の終了後にアクティベーションを実行する必要があります。 

ソフトウェア ID を入力してから製品のアクティベーションを実行すれば、いつでもエッセンシャルバージョン（フリー
ウェア）から商用バージョンに切り替えることができます。 

デモバージョンからエッセンシャルバージョン（フリーウェア）に切り替えると、一部の機能が使用できなくなる場合
があります。たとえば、複数機器のデータを使用するテンプレートの作成機能や自動エクスポート機能は使用できなく
なります。プロフェッショナルバージョンにのみ対応した機器のデータは、エッセンシャルバージョン（フリーウェ
ア）では読み出すことができなくなります。 
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1. 概要 

1.1 序文  
レポート生成ソフトウェアは、記録されたデータの一元管理と視覚化を実現します。 

これにより、以下のような測定点のデータをすべて文書化できます。 

 測定値 

 診断イベント 

 レポート 

評価ソフトウェアでは、データは SQL データベースに保存されます。データベースは現
場またはネットワークで操作できます（クライアント/サーバー）。 

 
エッセンシャルバージョンでは、ネットワーク内に保存されているデータベースに対し
て、複数の PC から同時にアクセスすることはできません。 

1.2 安全性に関する注記とアイコン 

  
注意：指示に従わなかった場合、機器の損傷または故障が発生する可能性があります。 
 

 
ヒント：追加情報を示します。 

  

1.3 安全上の注意事項   

 
下記の点に注目してください： 

• 弊社は不正な使用あるいは使用目的と異なる用途により発生する損害に対して責任
を負いません。 

• システムに接続する機器の取扱説明書に記載された安全上の注意事項をすべて順守
してください。 

• 計測システムの設置、設定、操作、メンテナンスは、訓練を受け、施設責任者から
許可を得た作業員のみが実施してください。作業員は取扱説明書を読み、内容を理
解した上で、記載されている指示に従ってください。 
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1.3.1 免責事項  

本ソフトウェアおよび対応する関連資料は、事前通知なしに製造者によって改訂および
更新される可能性があります。改訂または更新が発生した場合、改訂版または更新版の
ソフトウェア/対応する関連資料について、無償での自動配布を求める権利はエンドユー
ザーにはありません。 

ソフトウェアの改訂または更新の実施の有無および実施時期は、製造者の裁量により決
定されるものとします。 

関連資料には、印刷版の取扱説明書と簡易取扱説明書が含まれます。印刷版の取扱説
明書は、表紙に記載されたバージョンに対して有効です。現在インストールされてい
るバージョン番号については、「Help（ヘルプ）」メニュー項目を参照してください。 

また、本ソフトウェアがすべてのハードウェアプラットフォーム上で動作すること、あ
るいはその他のソフトウェアと併用できることについて、一切の保証を提供しません。
これにより発生したあらゆる損害に伴う請求に対して弊社は一切の責任を負いません。 

 
エンドユーザー用の使用許諾契約の全文については、インストール後にメインメニュー
「Help -> License agreement（ヘルプ -> ライセンス契約）」からいつでも確認できます。 

 

1.3.2 FDA 認定に対応した Memograph M RSG45 の安全上の注意事項 

 
FDA 21 CFR Part 11 準拠に関する以下の項目は、ユーザー側の責任において実施してく
ださい。 

o 自動システムサービスの終了は、Windows のユーザー権限によって制御する必
要があります。 

o ユーザーがソフトウェアからログアウトしていない場合、Windows のシステム
設定により自動的にスクリーンセーバーが起動します。 

o ソフトウェアを操作できるのは、Windows ログインを使用した場合のみです。
ユーザーは、PC から離れる場合、PC を保護（ロック）する必要があります。 

o 管理者がパスワードを忘れてしまった場合、期限付きのマスターパスワードを使
用できます。これは、要求を受けてから承認後にクライアントに送信されます。 

o ID とパスワードによる保護なしにソフトウェアを使用することも可能です。こ
の場合、クライアントがソフトウェア使用の責任を負うものとします。 

o 本ソフトウェアの「Extras -> Settings -> User administration（その他 -> 設定 -> 
ユーザー管理）」にある「Enable user management（ユーザー管理の有効
化）」と「Password protection compliant to FDA21 CFR PART 11（FDA21 CFR 
PART 11 に準拠したパスワード保護）」を選択してください。 

o ID の誤用や悪用を防止するために、ユーザーの初回ログイン時にパスワードを
変更してください。 

o パスワードの有効期間を設定できます。これは管理者の責任において実施してく
ださい。 

o PC の時刻は PC ソフトウェアの監査証跡に使用され、タイムスタンプの編集が可
能です。PC の時刻変更については、事業者の責任において実施してください。 

o 監査証跡に ID とユーザー名を記録するには、ユーザー管理を有効にする必要が
あります。 

o ユーザーは、データバックアップや予知保全を定期的に実施する必要があります。 



概要 

 

11 
 

o データの印刷後、ユーザーは画面に表示されたデータとプリントアウトを手動で
照合して印刷内容が正しいことを確認してください。また、必要に応じて、「非
電子」署名をプリントアウトに別途提供することで、データの完全性を承認して
ください。 

o プリンタの設定が、使用できないプリンタに変更されると、印刷できなくなりま
す。本ソフトウェアで、機器や機器パラメータの設定を行うことはできません。 
例外：本ソフトウェアでは、機器の時刻を同期させることができます。その場合、
PC と機器の時刻の差が一定の許容範囲内に収まっている必要があります。それ
以外の場合、機器では時刻が承認されません。PC の正確な時刻設定については、
事業者の責任において実施してください。 

o エラーリスト（ログファイル）を定期的に確認することをお勧めします。
「Automatic -> Job Type: Event view（自動 -> ジョブタイプ：イベントビュー）」
で「WindowsServiceLog.txt」が生成されます。 

o 表示内容の印刷時に、値、図表、イベント、監査証跡の入力項目の出力を制限す
ることができます。標準設定の変更については、ユーザーの責任において実施す
るものとし、その変更は監査証跡に記録されます。 

 

1.3.3 登録商標 

PentiumTM：IntelTM Corporation の登録商標です。 

AMDTM：Advanced Micro Devices の登録商標です。 

WindowsTM、VistaTM、Microsoft SQL ServerTM 、Active DirectoryTM：MicrosoftTM 
Corporation の登録商標です。 

OracleTM：OracleTM Corporation の登録商標です。 

CodeMeter®：WIBU SYSTEMS の登録商標です。 

1.4 ハードウェア/ソフトウェア要件 

本 PC ソフトウェアをインストールして使用するには、以下の要件を満たす必要があります。 

1.4.1 ハードウェア： 

1.4.1.1 FDM ソフトウェアのハードウェア要件 

• Pentium 4（≥2 GHz）を搭載した PC  

• Pentium M（≥1 GHz）を搭載した PC 

• AMD（≥1.6 GHz）を搭載した PC 

• 1 GB 以上の RAM キャッシュ 

• 20 GB 以上のハードディスクの空き容量 

• 1024 x 800 ピクセル以上の画面解像度 

• CD/DVD ドライブ（ドライブが搭載されていないコンピュータの場合は、
ソフトウェアを Endress+Hauser ソフトウェアポータルからダウンロードす
ることも可能（1.5 章「インストール」を参照））。 
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1.4.2 ソフトウェア： 

1.4.2.1 FDM ソフトウェアのオペレーティングシステム/ソフトウェア 

• Microsoft Windows Server 2003 R2 SP2 Standard、Enterprise 

• Microsoft Windows Server 2008、2012、2016、2019 

• Microsoft XP SP3 

• Microsoft Vista 

• Windows 7 

• Windows 8, Windows 8.1 

• Windows 10 

• Windows .NET 2.0 SP1 

1.4.3 インストール作業に必要なユーザー権限 

• Windows 管理者ユーザー権限でのログイン 

• ユーザーアカウント制御（UAC）の確認（有効な場合）  

1.4.4 インストールで変更される内容： 

1. インストールディレクトリの追加 

2. インストールディレクトリへのファイルのコピー 

3. アプリケーションディレクトリの追加 

• Windows 2000：%system drive%\Documents および Settings\All 
Users\Application Data\Endress+Hauser  

• Windows XP：%system drive%\Documents および Settings\All 
Users\Application Data\Endress+Hauser  

• Windows Server 2003：%system drive%\Documents および Settings\All 
Users\Application Data\Endress+Hauser  

• Windows Vista、Windows 7、Windows 8、Windows Server 
2008：%system drive%\ProgramData\Endress+Hauser 

4. Windows .NET 2.0 SP1 のインストール（オプション） 

5. Field Data Manager Windows Service（FDM WS）のインストール（自動実
行、オプション） 

6. Field Data Manager Tray Icon Application（FDM TI App）のインストール
（自動実行、オプション） 

7. PostgreSQL サーバーのインストール（オプション） 

8. WIBU CodeMeter ライセンスサーバーのインストール 

9. プログラムショートカットの作成 

10. レジストリの登録 

11. インストールログファイルの作成（%tmp%）  
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1.4.5 コンポーネント 

1.4.5.1 FDM TrayIcon Application 

（ログインユーザーの権限を使用して実行） 
以下のディレクトリに対する読取/書込アクセス： 

• インストールディレクトリ 

• アプリケーションディレクトリ 

• 割り当てられたネットワークドライブ（オプション） 

1.4.5.2 FDM Webservice 

（ローカルシステムアカウントを使用して実行） 

以下のディレクトリに対する読取/書込アクセス： 

• インストールディレクトリ 

• アプリケーションディレクトリ 

• 割り当てられたネットワークドライブ（オプション） 

1.4.5.3 FDM アプリケーション 

（ログインユーザーの権限を使用して実行） 

以下のディレクトリに対する読取/書込アクセス： 

• インストールディレクトリ 

• アプリケーションディレクトリ 

•  %tmp%  

1.4.6 ファイアウォール 

• フィールド機器用の通信ポート（初期設定：TCP ポート 8000、8001、8002、8007 
送受信） 

• Microsoft SQL データベースサーバー（初期設定：TCP 1433、送受信） 

• PostgreSQL データベースサーバー（初期設定：TCP 5436、送受信） 

• Oracle データベースサーバー（初期設定：TCP 1521、送受信） 

• LDAP ネットワークサービス（オプション、初期設定：TCP/UDP ポート 389、 
送受信） 

• ネットワークプリンタ（オプション） 

• Wibu CodeMeter ライセンスサーバー（標準：TCP ポート 22350） 

1.4.7 ユーザー 

セクション 1.4.5 コンポーネント を参照 

1.4.8 ユーザーアカウント制御（User Account Control：UAC） 

インストール後に特別な認証を行う必要はありません（FDM ユーザーが FMD WS を起
動/停止する場合を除く）。 
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1.5 インストール/アンインストール 

 
付属の簡易取扱説明書に記載のインストールに関する詳細な説明を参照してください。 

1. DVD を挿入します。 

2. 自動起動が有効な場合、自動的にインストールが開始されます。それ以外の場合は、 

3. DVD から「Setup.exe」を起動します。 

4. インストールプログラムの指示に従います。 

自動コンポーネントのインストールを確定すると、追加の Windows システムサービスが
設定されます。このシステムサービスにより、レポート生成ソフトウェアからの自動処
理の実行と制御が可能になります。これには、機器データの自動読出し、レポートの自
動印刷、レポートの自動生成などがあります（セクション 4.4 「Automatic（自動）」を
参照）。 

 
CD/DVD ドライブが搭載されていないコンピュータの場合は、FDM を Endress+Hauser 
ソフトウェアポータルからダウンロードすることも可能です。そのためには、次のソフ
トウェアポータルのアカウントが必要です。https://software-products.endress.com 

1. ZIP ファイルをダウンロードしてローカルに保存します。 

2. ZIP ファイルを解凍します。 

3. Setup.exe を起動し、インストールプログラムの指示に従います。 

 
サポートされているデータベースは以下のとおりです。 

 PostgreSQL バージョン 9.2～11（対応バージョン：エッセンシャル、デモ、 
プロフェッショナル）： 

インストール用 DVD で提供される無償の PostgreSQL データベースをインストールして
使用できます。手動のインストール/設定作業は不要です。データベースはインストール
時に自動的に設定されます。 

 Oracle （対応バージョン：デモおよびプロフェッショナル）： 
バージョン 8i～12c。Oracle データベースを使用する場合のレポート生成ソフトウェア
の設定については、お客様のデータベース管理者にお問い合わせください。付属の簡易
取扱説明書に記載のインストールに関する詳細な説明を参照してください。 

 Microsoft SQL Server （対応バージョン：デモおよびプロフェッショナル）： 
バージョン 2005～2019。Microsoft SQL Server を使用する場合のレポート生成ソフト
ウェアの設定については、お客様のデータベース管理者にお問い合わせください。付属
の簡易取扱説明書に記載のインストールに関する詳細な説明を参照してください。 

1.5.1 ソフトウェアライセンス  

1.5.1.1 ライセンスサーバー 

バージョン 1.4.0 より、設定の一環として WIBU CodeMeter がインストールされます。
CodeMeter は、本ソフトウェアのラインセンスおよび他の製造者のソフトウェアツール
のライセンスを管理します。 
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1.5.1.2 ハードウェアの交換 

ハードウェア（FDM がインストールされているコンピュータ）を交換する場合、または
仮想環境（VM イメージ）を変更する場合、事前に FDM ライセンスを返却し、再インス
トール後に再びアクティベーションを行う必要があります。セクション 1.7.2 を参照し
てください。 

1.5.1.3 ライセンス違反/ライセンスのブロック 

ライセンスの誤用やハードウェアの交換がライセンス違反と見なされる場合があります。
この場合、FDM を使用できなくなり、ライセンスのサポートが失われます。メンテナン
スや障害復旧を行う場合、この点を十分に考慮してください。 

1.5.1.4 代替ライセンス 

障害復旧をクライアント側で行い、ライセンスを返却できない場合、Endress+Hauser へ
の通知なしに、FDM の再アクティベーションを独自に実行することができます。 

1.5.1.5 仮想環境 

ホストを「移行」した場合、FDM は同じホスト上の仮想環境をサポートします。同じホ
スト内の VM イメージのコピー（移動）または別のホストへの VM イメージのコピー
（移動）はサポートされません。  

 

1.5.2 ソフトウェアのアップデート/アップグレード 

付属の簡易取扱説明書に記載のインストールに関する詳細な説明を参照してください。 

1.5.3 ソフトウェアのアンインストール 

ソフトウェアをアンインストールする場合は、以下の手順を実行してください。 

1. ライセンスを返却します（セクション 1.7.2 を参照）。 

2. 自動サービスを無効化し、トレイアイコンアプリケーションと分析ソフトウェア
を終了します。 

3. コントロールパネルの「Uninstall or change a program（プログラムのアンイン
ストールまたは変更）」で、「Field Data Manager x.x.x.」ソフトウェアを選択
します。 

4. 「Uninstall（アンインストール）」を選択して画面の指示に従います。 

 
WIBU CodeMeter はシステムで保持され、アンインストールされません。 

1.6 プログラムの起動、操作言語の選択 

「Start -> Programs（開始 -> プログラム）」で、新しくインストールされた「Field 
Data Manager Software」プログラムを見つけます。プログラムを起動します。必要に応
じて、「Extras -> Settings -> Language（その他 -> 設定 -> 言語）」で操作言語を変更し
ます。変更した操作言語は、プログラムの再起動後に適用されます。 
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1.7 ライセンスの管理とソフトウェアのアクティベーション 

 
プロフェッショナルバージョンを使用するには、有効なソフトウェア ID を使用してソフ
トウェアのアクティベーションを行う必要があります。 
ソフトウェアのアクティベーションを実行していない場合、プログラムの起動時に以下
の通知が表示されます。 

 
 

1.7.1 ソフトウェアのアクティベーション 

ソフトウェアのアクティベーションを行うには、以下の手順を実行します。 

1. メニュー項目「Help -> License information（ヘルプ -> ライセンス情報）」をク

リックします。 

2. 「License information（ライセンス情報）」をクリックします。 
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3. 「Activate software（ソフトウェアのアクティベート）」をクリックします。 
 

 
ソフトウェアのアクティベーションを行うには、以下の Endress+Hauser ソフト
ウェアポータル用のアカウントが必要です。 
https://software-products.endress.com 
 
ソフトウェアポータルでは、Endress+Hauser 製品のライセンスを管理できます。
ソフトウェアポータルへのログインに必要な情報については、お客様の会社のラ
イセンス管理担当者にお問い合わせいただくか、あるいは「Create account（ア
カウントの作成）」をクリックします。 
 

 

4. 「Activate now（アクティベート）」をクリックします。 

 
手動アクティベーション（オフラインアクティベーション） 
オンラインアクティベーションを実行できない場合、自動的に手動アクティベーション
に切り替わります。手動アクティベーション用のダイアログボックスが表示されます。
指示に従ってください。  
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1.7.2 ライセンスの返却 

ソフトウェアを新しいコンピュータにインストールする場合などには、それまで使用し
ていたライセンスを Endress+Hauser ソフトウェアポータルに返却する必要があります。 

 
ラインセンスを返却すると、そのコンピュータではソフトウェアを使用できなくなります。 

ソフトウェアを新しいコンピュータにインストールすると、ライセンスの再アクティ 
ベーションが可能になり、ソフトウェアを再び使用できるようになります。 

ライセンスを返却するには、以下の手順を実行します。 

1. メニュー項目「Help -> License information（ヘルプ -> ライセンス情報）」をク
リックします。 

2. 「License Information（ライセンス情報）」をクリックします。 

 

3. 「Return license（ライセンスの返却）」をクリックします。以下のダイアログ
ボックスが表示されます。 
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4. ログイン情報を入力し、もう一度「Return license（ライセンスの返却）」をク
リックしてログイン情報を確定します。 

ライセンスの返却が正常に完了したことを示す確認通知が届きます。 

 

 
ライセンスの手動返却（オフラインモード） 
オンラインでライセンスを返却できない場合、自動的に手動ライセンス返却に切り替わ
ります。手動ライセンス返却用のダイアログボックスが表示されます。指示に従ってく
ださい。 

 
 

1.7.2.1 ライセンスのアップグレードとアップデートライセンスのアップグレード 

機能やモジュールの追加、ユーザーの追加（マルチユーザーライセンス）が必要な場合、
それに応じてライセンスをアップグレードできます。 

1. Endress+Hauser の営業所もしくは販売代理店にお問い合わせください。 

2. ニーズに適したライセンスアップグレードを注文します。Endress+Hauser がお
客様のライセンスをアップグレードし、ライセンスアップグレードの確認通知を
お送りします。 

3. ライセンスアップグレードの確認通知が届きましたらライセンスを更新してくだ
さい。 

4. 「Help -> License Information -> License Information（ヘルプ -> ライセンス情報 
-> ライセンス情報）」でライセンスを確認します。 
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1.7.2.2 ライセンスのアップデート 

ライセンスのアップデートとは、お客様が Endress+Hauser との契約を更新し、新しい機
能や追加ライセンスを購入することを意味します。契約に含まれる新しいコンポーネン
トのアクティベーションを行う場合は、単にライセンスを更新してください。 

 
ライセンスを更新する場合、ソフトウェアの再インストールは不要です。 

ライセンスのアップグレードに伴いソフトウェアを更新する場合、以下の手順を実行し
ます。 

1. メニュー項目「Help -> License Information（ヘルプ -> ライセンス情報）」をク
リックします。 

2. 「License Information（ライセンス情報）」をクリックします。 

 
 

3. 「Update license（ライセンスのアップデート）」をクリックします。 
 

 
ライセンスを更新するには、以下の Endress+Hauser ソフトウェアポータルのア
カウント用のログイン情報が必要です。 
https://software-products.endress.com. 
ソフトウェアポータルへのログインに必要な情報については、お客様の会社のラ
イセンス管理担当者にお問い合わせください。 
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4. 「Update license（ライセンスのアップデート）」をクリックします。 

更新が正常に完了したことを示す確認通知が届きます。 
 

 
手動ライセンス更新（オフラインモード） 
オンラインで更新できない場合、自動的に手動ライセンス更新に切り替わります。手動
ライセンス更新用のダイアログボックスが表示されます。指示に従ってください。  
 

 

 

アップデートの検索本ソフトウェアには、更新検索用のオプションが用意されています。 

 
この機能は、プロフェッショナルバージョンでのみ使用できます。 

更新が利用可能であり、お使いのバージョンを更新する場合は、Endress+Hauser の営業
所もしくは販売代理店にお問い合わせください。 
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1.「Help -> License information（ヘルプ -> ライセンス情報）」をクリックします。
以下の画面が表示されます。 
 

 
2. 「アップデートの確認をクリックします。 

3. Endress+Hauser のサーバーへの接続が確立され、ウェブブラウザのウィンドウ
が開きます。このウィンドウには、利用可能な更新の有無を示すメッセージが表
示されます。 
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1.8 スタートアップガイド（ReadWin 2000 からの移行） 

 
ReadWin 2000 とは異なり、レポート生成ソフトウェアは機器設定をサポートしていま
せん。 

レポート生成ソフトウェアでは、ReadWin 2000 のすべてのデータ読出機能が「Data 
Readout（データ読み出し）」タスクに統合されています。このタスクでは、機器にオ
ンラインで接続されたインターフェイスを使用して、あるいはデータ記憶媒体を使用し
てデータを読み出すことができます。 

また、レポート生成ソフトウェアでは、読み出したデータを表示する機能が
「Visualization（可視化）」という 1 つのタスクに統合されています。表示モード（バー
グラフ – ヒストグラム、折れ線グラフ、表）を選択して、チャート設定またはチャンネ
ル設定からデータを直接視覚化できます（Excel などと同じです）。つまり、個々のチャ
ンネルを 1 つのグラフにさまざまな方法で表示できます。 

ReadWin 2000 と新しいレポート生成ソフトウェアの機能の比較： 

 
レポート生成ソフトウェアでは、機器設定（通信、自動機能）は、機器を右クリックし
てプラントのツリー構造を使用して行うか、あるいは個別の視覚化手順または機器デー
タの読出時に直接行います。 

ReadWin 2000 と同様に、自動機能の設定は「Data Management –> Automatic（データ
管理 –> 自動）」の 1 か所にまとめられています。 

自動機能はシステムサービスとして設定され、バックグラウンドで実行されます。自動
タスクを実行するために、必ずしもレポート生成ソフトウェアの起動が必要となるわけ
ではありません。 

1.9 FieldCare のプラントビューの利用 

FieldCare のプラントビューを利用するには、最初に FieldCare からビューをエクスポー
トするか、またはビューを CSV ファイルとして保存する必要があります。これを行うた
めに、FieldCare では「File -> Import/Export -> Export as CSV（ファイル -> インポート/
エクスポート -> CSV として出力）」でプラントビューを CSV 形式でエクスポートし、
指定した場所に保存できます。これにより、この機器ツリーをレポート生成ソフトウェ
アで使用することができます。 

レポート生成ソフトウェアでは、別のプログラム（FieldCare など）で保存された既存の機
器ツリーやプラントビューを利用できます。この機能は「Data Management -> Plant View
（データ管理 -> プラントビュー）」タスクで使用できます。 

可視化 データ読み出し 
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「矢印付きボックス」  アイコンを押すと、コンピュータのメニュー構造が表示されま
す。保存場所を選択し、対応するプラントビューの CSV ファイルを選択します。これによ
り、ツリー構造がデータベースに読み込まれて保存されます。エンタープライズを選択し
て右クリックし、「Import Plant View（プラントビューのインポート）」を選択しても同
じ機能を使用できます（セクション 4.1 Data management -> Plant view（データ管理 -> プ
ラントビュー）  を参照）。 

 
エッセンシャルバージョンでは、一部の機器がサポートされないため、インポートでき
るのはサポート対象機器のデータのみです。 



概要 
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1.10 ReadWin 2000 からデータをインポート 

データの改ざんを防止しながら ReadWin 2000 のデータをレポート生成ソフトウェアの 
SQL データベースにインポートするには、最初に ReadWin 2000 から保護付きのデータ
をエクスポートします。これを行うには、対応する機器のデータを記憶媒体またはドラ
イブにエクスポートします（その他 -> 測定された値の保存）。 

 

 
 

 
 

次に、レポート生成ソフトウェアのインポート機能を使用して、各機器のデータを SQL 
データベースにインポートします。この場合、データ形式には「rsd」を選択してくださ
い。セクション 4.3（81 ページ）のインポート機能の説明を参照してください。 
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1.11 メインウィンドウ  
以下の図は、レポート生成ソフトウェアのユーザーインターフェイスの全体的なレイア
ウトを示します。 

 
 

1.11.1 メインメニュー  
上部のメインメニューにはメニューバーが配置されており、各メニュー項目はソフト
ウェア設定に関する機能グループを示します。 
File（ファイル） -> プログラムの終了 
View（ビュー） -> ビューの設定 
Extras（その他） -> データベース、言語、ユーザー管理、監査証跡の設定 
Help（ヘルプ） -> オンラインヘルプの起動、ソフトウェア情報の表示、ライセンスの変
更/アクティベーション 

1.11.2 ツールバー  

ドック可能なウィンドウ内のツールバーを使用すると、印刷、保存、オンラインヘルプ
などの機能にすばやくアクセスできます。 

1.11.3 Task Pane（タスクペイン） 

左側にはタスクペインが配置されています。メインメニューの「View（ビュー）」機能
を使用して、タスクペインの表示/非表示を切り替えることができます。タスクをクリッ
クすると、そのタスクが表示されます。以下の機能が表示されます。 

データの読み出し -> 大容量記憶装置または機器へのオンライン接続を使用したデータの
読出し 

可視化 -> 視覚化用テンプレートの表示、編集、削除、新規作成 



Task pane -> Read Out Data（タスクペイン -> データの読み出し） 
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データ管理 -> プラントビュー、機器データのエクスポート/インポート 

1.11.4 メインウィンドウ  
メインウィンドウにはドック可能なウィンドウが表示されます。ドック可能なウィンド
ウが複数存在する場合は、タブが表示されます。 

1.11.5 ドック可能なウィンドウ  

ドック可能なウィンドウは、メインウィンドウ内でドックすることができ、また、ウィ
ンドウの外側に配置することもできます。他のウィンドウの邪魔にならないようにウィ
ンドウを配置できます。ウィンドウを閉じるためのボタン（X）が右側にあります。 
ドック可能なすべてのウィンドウの上部にはタイトルバーがあり、サブ要素の名前と対
応するアイコンが左側に表示されます。ウィンドウ固有のアイコン、クイック情報や機
能などを含むツールバーがタイトルバーの下に配置されます。ドック可能なウィンドウ
のメイン領域はツールバーの下から始まります。 

1.11.6 ステータスバー  
ステータスバーには、ログインステータスやその他の情報が表示されます。 

1.11.7 スプリッタ  

Splitter は タスクペインとメインウィンドウを分離します。タスクペインとメインウィ
ンドウが表示されている場合にのみ、Splitter を移動させることができます。Splitter の
位置を変更すると、タスクペインとメインウィンドウのサイズが変更されます。 

2. Task pane -> Read Out Data（タスクペイン -> データの読み出し） 

データを読み出してデータベースに保存します –「Read Out Data（データの読み出し）」 

タスクペインの「Read Out Data（データの読み出し）」タスクを選択すると、設定を
実行して、機器に保存されている測定データやその他のデータを読み出すのと同時に、
データの改ざんを防止しながらデータベースにデータを保存できます。 

レポート生成ソフトウェアに付属する無償の PostgreSQL データベースまたは既存の SQL 
データベース（Oracle および Microsoft SQL Server）をターゲットデータベースとして使
用できます。データベースの選択に関する設定については、セクション 5.1.2 を参照し
てください。 

 エッセンシャルバージョンは、付属する無償の PostgreSQL データベースのみを
サポートします。 

「Read Out Data（データの読み出し）」タスクでは、「マスストレージ」と「オンライ
ン接続」という 2 種類の読出しを使用できます。 

対応するアイコンをクリックすると、画面の右半分に新しい作業ウィンドウが表示され
ます。このウィンドウで、手順を確認しながら所定の作業項目を実行できます。 

上部のアイコンを利用すると、個々の手順に移動することができます。 

• （緑色の左矢印）：「Back（戻る）」ボタンに相当します。前の手順に移動します。 

• （緑色の右矢印）：「Nex（次へ）」ボタンに相当します。次の手順に移動します。 
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• （疑問符）：ヘルプ。当該手順のヘルプ機能を呼び出します。 
 

2.1 データの読み出し -> マスストレージ;データノヨミダシ -> マススト
レージ 

このタスクでは、SD カード、USB メモリ、ドライブなどの記憶媒体からデータ（バイナ
リ *.dat）を読み出して保存できます。 

2.1.1 Step 1/3：データソースの選択  

読み出すデータがどこに保存されているかを指定します。 

データソースを選択します。 

「…」ボタンを押すと、Explorer のフォルダとインターフェイス構造およびワークステー
ションが表示されます。 

ドロップダウンメニューには、以前に使用された保存場所や記憶媒体が表示されます。 

 
 

読み出すデータのデータソースまたは保存場所を選択すると、「Next（次へ）」を使用
して次の手順に進むことができます。 

「Cancel（キャンセル）」をクリックすると、この処理が終了してウィンドウが閉じ、
プロセスが中止されます。 



Task pane -> Read Out Data（タスクペイン -> データの読み出し） 
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2.1.2 Step 2/3：機器の選択  

どの機器からデータを読み出すかを指定します。 

この 2 番目の手順では、該当する機器とデータの時間範囲を選択します。 

 
 

「Devices（機器）」領域には、記憶媒体上で検出された機器が表示されます。 

これにチェックマークを入れることで、機器を選択できます。したがって、記憶媒体の
すべてのデータを読み出す必要はありません。 

すべての機器を選択する場合は、「Select All（全てを選択）」ボタンを使用します。
「Unselect All（すべてを選択解除）」を押すと、すべての選択が解除されます。 

「Delete Files after Import（読み込み後のファイル削除）」のボックスにチェックマーク
を入れると、選択したデータがデータベースに正常に保存されると、そのデータはデー
タ記憶媒体から即座に削除されます。 

 記憶媒体からデータが削除された後に、これを取り消すことはできません。 

データを読み出す機器の選択が完了したら、保存するデータの容量を指定します。この
データは次の手順で読み出されます。 

選択を完了する場合は「Next（次へ）」を押します。 

前のビューに戻る場合は「Back（戻る）」を選択します。 

「Cancel（キャンセル）」をクリックすると、この処理が終了してウィンドウが閉じ、
プロセスが中止されます。 
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2.1.3 Step 3/3：データの読み出し  

指定したデータを読み出してデータベースに保存します。 

進捗バーに進捗状況が % 単位で示され、推定の残り時間が表示されます。読出しプロセ
スの所要時間は、データ容量と使用する記憶媒体に応じて異なります。この手順の実行
中に処理を中止する場合は「Cancel（キャンセル）」ボタンを押します。前のビューに
戻る場合は「Back（戻る）」を選択します。 

処理が完了すると、進捗バーの下に確認メッセージが表示されます。 

 
 

これで、手順 1 と 2 で指定したデータが記憶媒体から正常に読み出され、データベース
に保存されます。 
手順 2 で「Delete Files after Import（読み込み後のファイル削除）」チェックボックス
をオンにした場合、記憶媒体から保存データが正常に削除されます。 

「Close（閉じる）」を選択してプロセスを終了します。ウィンドウが閉じます。 
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2.2 データの読み出し -> オンライン接続 

2.2.1 作成済みの機器からデータを読み出す 

2.2.1.1 Step 1/5：機器の選択 

どの機器からデータを読み出すかを指定します。 

 エッセンシャルバージョンでは、一部の機器がサポートされていません。設置
されているサポート対象外の機器は、その設定とともに表示されます。ただし、使用可
能な機能をこれらの機器に適用することはできません。 

手順 1 では読み出す機器を選択します。ビューには作成済みのプラントビューが表示さ
れます。このビューを再構築して拡張することができます（セクション 4.1 Data 
management -> Plant view（データ管理 -> プラントビュー） を参照）。 

 
「Memory card in device（機器内のメモリーカード）」ボタンと「Device memory（機器
メモリ）」ボタンを使用して、読み出す機器データを選択します。 
「Memory card in device（機器内のメモリーカード）」：選択した機器のメモリーカー
ドのデータを読み出します。 
「Device memory（機器メモリ）」：選択した機器の内部メモリのデータを読み出します。 

選択したデータがデータベースに正常に保存されると、そのデータは機器メモリまたは
機器のメモリーカードから即座に削除されます。 

 
データの削除後に、これを取り消すことはできません。 

即時読出しを実行にするには、右クリックしてから「データの読み出し」をするか、ま
たは「Next（次へ）」を選択します。その後、手順 5「Read Out Data（データの読み出
し）」が開きます。 
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通信インターフェイスを使用してデータを読み出すには、機器との通信を設定する必要
があります。プラントビュー（この手順）で機器を作成するときに、データ管理から通
信を設定または修正できます。 

機器を選択して右クリックし、「Configure Interface...（インターフェースの設定...）」
を選択すると、通信設定が表示されます。 

 
「Cancel（キャンセル）」をクリックすると、この処理が終了してウィンドウが閉じ、
プロセスが中止されます。 

2.2.1.2 Step 2/5：機器の設定  

保存された機器に機器設定が保存済みの場合、Step 2 は自動的に省略されます。 

2.2.1.3 Step 3/5：自動設定  

保存された機器に自動設定が保存済みの場合、Step 3 は自動的に省略されます。 
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2.2.1.4 Step 4/5：機器情報 

手順 1 で「機器内のメモリーカードの読み出し」を選択した場合： 
ソフトウェアでは機器への接続テストが行われ、特定の機器情報が読み込まれます。 
画面にメモリーカードのデータが表示されます。これらのデータを個別に選択して読み
出すことができます。 

 
選択する機器または通信設定を変更する場合は、「Back（戻る）」を使用して前の手順
に戻ることができます。 

「Next（次へ）」ボタンをクリックすると、機器データの読出しが実行されます。 

「Cancel（キャンセル）」をクリックすると、この処理が終了してウィンドウが閉じ、
プロセスが中止されます。 

手順 1 で「Readout device memory（機器メモリの読み出し）」を選択した場合： 
Step 4 は自動的に省略され、機器メモリからすべてのデータが読み出されます。 
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2.2.1.5 Step 5/5：データの読み出し  

指定したデータを読み出してデータベースに保存します。 

進捗バーに進捗状況が % 単位で示され、推定の残り時間が表示されます。読出しプロセ
スの所要時間は、データ容量と使用する記憶媒体に応じて異なります。この手順の実行
中に処理を中止する場合は「Cancel（キャンセル）」ボタンを押します。前のビューに
戻る場合は「Back（戻る）」を選択します。 

処理が完了すると、進捗バーの下に確認メッセージが表示されます。 

 
 

これで、指定したデータが機器から正常に読み出され、データベースに保存されます。
さらに、機器メモリから保存データが正常に削除されます。 

「Close（閉じる）」を選択してプロセスを終了します。ウィンドウが閉じます。 
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2.2.2 未作成の新しい機器を読み出す 

2.2.2.1 Step 1/5：機器の選択または新しい機器の作成 

ビューには作成済みのプラントビューが表示されます。このビューを再構築して拡張す
ることができます（セクション 4.1 Data management -> Plant view（データ管理 -> プラ
ントビュー） を参照）。 

読み出す機器をまだ作成していない場合、「New Device（新しい機器）」ボタンを使用
して新しい機器を作成できます。このボタンを押すと、手順 2 に移動します。 

 
 

「Cancel（キャンセル）」をクリックすると、この処理が終了してウィンドウが閉じ、
プロセスが中止されます。 
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2.2.2.2 Step 2/5：機器の設定  

手順 2 では、作成して読出しを行う新しい機器を設定します。 

これを行うために、「Select Source（ソースの選択）」領域で機器とのインターフェイ
ス、機器タイプ、読出しを行うメモリ（機器メモリ、大容量記憶装置）を設定します。 

機器の自動検出：機器の自動検出機能を使用する場合、必要なインターフェイスパラ 
メータを指定したときに機器タイプが自動的に検出されます。自動検出機能は標準で有
効になっています。機器の自動検出機能を無効にした場合、インターフェイスを指定す
ると、サポートされるすべての機器タイプのドロップダウンリストが表示されます。 

その後、下部領域で通信/インターフェイスの詳細設定を行います。 

  
「The device is read out by more than one Reporting Software（機器は複数のレポーティ
ングソフトウェアで読み取られます）」にチェックマークを入れると、最大 4 台の PC 
への読出しが可能になります。 

「Repeat readout periodical（周期読み出しの繰り返し）」にチェックマークを入れると、
自動読出しが定期的に実行されます。次の手順または自動設定（セクション 6.3 を参
照）で、該当する機器の自動機能を設定できます。自動読出しを行うには、機器への常
時接続が必要です。 

「Next（次へ）」ボタンまたはメインツールバーの緑色の矢印を押すと、次の手順に移
動します。 
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2.2.2.3 Step 3/5：自動設定  

 
これは、前の手順で「周期読み出しの繰り返し」を選択した場合にのみ設定できます。 

 

Data read out（データ読み出し）： 
ここでは自動機能を実行する周期を指定します。このために「Active（有効）」チェッ
クボックスを選択する必要があります。 
Interval（間隔）：エクスポートを実行する頻度。 
選択した周期に応じて、開始日、開始時刻などの繰返しに関するデータを指定します
（セクション 6.3 を参照）。 

Time synchronize（時刻の同期）： 
ここでは機器の時刻とコンピュータのシステム時間を同期させることができます。 
同期を行う周期を指定するには、「Active（有効）」チェックボックスを選択する必要
があります（セクション 6.5 を参照）。 

「Next（次へ）」ボタンまたはメインツールバーの緑色の矢印を押すと、次の手順に移
動します。 
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2.2.2.4 Step 4/5：機器情報 

機器に設定されている通信をテストします。 
ソフトウェアでは機器への接続テストが行われ、特定の機器情報が読み込まれます。 

さらに、「Readout memory card in device（機器内のメモリーカードの読み出し）」を
選択した場合（手順 2）、メモリーカードに保存されているデータが表示され、そこか
ら読出し対象としてデータを個別に選択することができます。 

 
選択する機器または通信設定を変更する場合は、「Back（戻る）」を使用して前の手順
に戻ることができます。 

「Next（次へ）」ボタンをクリックすると、機器データの読出しが実行されます。 

選択したデータがデータベースに正常に保存されると、そのデータは機器メモリまたは
機器のメモリーカードから即座に削除されます。 

 
データの削除後に、これを取り消すことはできません。 

「Cancel（キャンセル）」をクリックすると、この処理が終了してウィンドウが閉じ、
プロセスが中止されます。 
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2.2.2.5 Step 5/5：データの読み出し  

指定したデータを読み出してデータベースに保存します。 

進捗バーに進捗状況が % 単位で示され、推定の残り時間が表示されます。読出しプロセ
スの所要時間は、データ容量と使用する記憶媒体に応じて異なります。この手順の実行
中に処理を中止する場合は「Cancel（キャンセル）」ボタンを押します。前のビューに
戻る場合は「Back（戻る）」を選択します。 

処理が完了すると、進捗バーの下に確認メッセージが表示されます。 

 
これで、指定したデータが機器から正常に読み出され、データベースに保存されます。
さらに、機器メモリまたは機器のメモリーカードから保存データが正常に削除されます。 

「Close（閉じる）」を選択してプロセスを終了します。ウィンドウが閉じます。 
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3. Task pane -> Visualization（タスクペイン -> 可視化） 

Task ペインの「Visualization（可視化）」タスクには、現在の保存データの表示に関連
するすべての項目が含まれます。 

基本機能として「New（新規）」、｢Open（開く）」、｢Edit（編集）」の 3 つを使用で
きます。 

｢New（新規）」機能では、新しい表示（テンプレート）を作成します。「Open（開
く）」をクリックすると、以前に定義して保存した表示（テンプレート）を使用できま
す。「Edit（編集）」をクリックすると、以前に定義したテンプレートを変更できます
（例：追加チャンネルの選択、テンプレートの削除）。 

対応するアイコンをクリックすると、画面の右半分に作業ウィンドウが表示されます。
このウィンドウで、手順を確認しながら目的の形式で保存データを表示するためのプロ
セスを実行できます。 

上部のアイコンを利用すると、個々の手順に移動することができます。作業ウィンドウ
内のグレー表示のアイコンは、当該の作業手順では使用できません。 

• （緑色の左矢印）：「Back（戻る）」ボタンに相当します。前の手順に移動し
ます。 

• （緑色の右矢印）：「Next（次へ）」ボタンに相当します。次の手順に移動し
ます。 

• （疑問符）：ヘルプ。当該手順のヘルプ機能を呼び出します。 

 
エッセンシャルバージョンでは、テンプレートにこのソフトウェアバージョンがサポー
トする機器のデータが含まれている場合にのみ、テンプレートの作成、表示、編集を行
うことができます。いずれの場合においても、テンプレートに割り当てることができる
機器は 1 台のみです。 
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3.1 保存データの視覚化  

3.1.1 Visualization -> New（可視化 -> 新規）  

3.1.1.1 Step 1/4：機器の選択  

手順 1 では、ソース機器を選択します。作業ウィンドウの左側に、プラントビューが
表示されます（セクション 4.1 Data management -> Plant view（データ管理 -> プラン
トビュー） を参照）。このビューには、データの視覚化が可能なすべての機器が表示
されます。 

 
エッセンシャルバージョンでは、サポートされる機器のみを選択できます。 
複数の機器を選択することはできません。 

作業ウィンドウの右側には、選択した機器の概要が表示されます。 

 
プラントビューの機器にチェックマークを入れて、表示される青色の矢印をクリックま
たはダブルクリックすることで、視覚化する機器を選択できます。 

後で、選択した機器のリストから機器を削除する場合は、右側のリストの機器を選択し
てからダブルクリックするか、または青色の左矢印をクリックすると、リストから削除
されます。 

少なくとも 1 台の機器を選択すると、「Next（次へ）」ボタンが表示されます。このボ
タンをクリックすると、次の手順に移動します。 

「Cancel（キャンセル）」をクリックすると、この処理が終了してウィンドウが閉じ、
プロセスが中止されます。 
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3.1.1.2 Step 2/4：チャンネルの選択  

手順 2 では、レポートとチャンネルを選択します。 

 
機能： 

Trend（トレンド）： 
Measurement values（測定値）：選択した機器の瞬時値（アナログ値）を選択できます。 

Reports（レポート）： 
選択した機器のレポートを選択できます（日次、週次、月次、外部など）（これらのレ
ポートが機器に保存されている場合にのみ選択可能）。 

Channels（チャンネル）： 
機器説明/TAG、Device type（機器タイプ）：ここには、選択した機器に関する情報が表
示されます。 
Min（最小）、Max（最大）、Average（平均）、Instantaneous（瞬時値）：機器のアナ
ログ値を選択します。 
Status（ステータス）：機器のデジタル値を選択します。 

 

視覚化するデータの分析とチャンネルを選択すると、「Next（次へ）」を使用して次の
手順に進むことができます。 

「Cancel（キャンセル）」をクリックすると、この処理が終了してウィンドウが閉じ、
プロセスが中止されます。 

前のビューに戻る場合は「Back（戻る）」を選択します。 
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3.1.1.3 Step 3/4：タイムスロットまたはバッチの選択 

手順 3 では、視覚化するデータのタイムスロット（またはバッチ（使用可能な場合））
を選択します。 

 
視覚化するデータのタイムスロットを少なくとも 1 つ選択すると、「Next（次へ）」を
使用して次の手順に進むことができます。 

 
同一の時間範囲を最大 3 つ選択できるため、相互に比較することができます。 

「Cancel（キャンセル）」をクリックすると、この処理が終了してウィンドウが閉じ、
プロセスが中止されます。 

前のビューに戻る場合は「Back（戻る）」を選択します。 
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3.1.1.4 Step 4/4：グラフ 

Step 4 では、選択したタイムスロットのグラフ、値とイベントが表示されます。 

 
 

以下のアイコンの機能を使用できます。 

 

• （ディスク）：表示を保存します。まだ保存していない場合、新しいテンプレー
トが作成されます。このテンプレートは、今後の視覚化処理に利用できます。 

• （ディスクとペン）：名前を付けて保存します。新しいテンプレートを作成し
て、そのテンプレートに新しい名前を割り当てます。 

• （矢印付きボックス）：エクスポート。選択したデータを *.csv または *.xls 形
式でエクスポートできます。 

• （プリンタアイコン）：印刷。現在のウィンドウを印刷できます。 

• （プレビュー）：印刷プレビューを生成します。 

• （Adobe Acrobat® アイコン）：PDF ファイルとしてエクスポートします。 
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（バーグラフ）：チャート設定を変更します。 
 

 

• （ピン）：値カーソルの有効/無効を切り替えます。カーソルをグラフの上に移
動させると、カーソルの位置に応じて、グラフの下に表示される値が自動的に更新
されます。マウスの左ボタンを押すと、「Values（値）」領域と「Events（イベン
ト）」領域に表示される値も更新されます。 

• （メモ帳）：コメントを追加します。グラフ領域にコメントを追加できます。
このオプションはグラフビューにのみ使用できます。 

• （更新）：選択期間が現在の時間に設定され、データが読み込まれます。 

• （虫眼鏡 +）：拡大 

• （虫眼鏡 -）：縮小 

• （虫眼鏡 1:1）：ズームのリセット 

• （歯車とプリンタ）：自動印刷 

• （歯車と Excel）：自動 Excel/CSV エクスポート 

• （歯車と Adobe Acrobat® アイコン）：自動 PDF 出力 

• （青矢印付き四角形）：グラフの最大化/最小化 

 
「自動印刷」、「自動 Excel/CSV エクスポート」、および「自動 PDF 出力」機能は、 
エッセンシャルバージョンではサポートされていないため、選択できません。 
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「Graph（グラフ）」領域： 
「Graph（グラフ）」領域のヘッダーをダブルクリックするとグラフビューが拡大され
て、全画面モードで表示されます。これは「グラフの最大化」アイコンと同じ機能です。
これを使用すると、余計なスクロール操作なしに作業を進めることができます。 

 
「Reduced data volume（データ量の削減）」というメッセージは、データ容量が自動的
に削減されて、グラフが集約されていることを意味します。これにより表示速度が向上
します。グラフを拡大した場合（複数倍）、すべての値を表示する必要があるため、こ
のメッセージは消えます。 
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グラフフィールドでマウスの左ボタンをクリックすると、フレームを描画できます。こ
れにより、選択した領域を拡大することができます。 

 
説明（右側）の項目をマウスの左ボタンでクリックすると、その他のチャート設定を含
むウィンドウが表示されます。 
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「Values（値）」領域： 
すべての値とタイムスタンプが表示されます。「Search（検索）」を選択すると、特定
の日時の値を検索できます。 

 カーソルが有効な場合にマウスの左ボタンを押すと、図表内のカーソルの位置に応
じて、表示される値が更新されます。 

 

「Program Logbook（プログラム履歴）」領域： 

サンプラの測定値が選択されている場合、プログラム履歴が追加領域に表示されます。
これには、選択した期間内に完了したすべてのサンプルプログラムが含まれます。
「Program Logbook（プログラム履歴）」ヘッダーの横に「ドキュメント」ボタンがあ
ります。 
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サンプルプログラムの選択が完了すると、「ドキュメント」ボタンを使用してこれを開
き、保存して印刷することができます。 

 

 

「Events（イベント）」領域： 
ここには、選択した機器のイベントが表示されます。 

 カーソルが有効な場合にマウスの左ボタンを押すと、図表内のカーソルの位置に応
じて、表示されるイベントが更新されます。 

 
「Close（閉じる）」を選択して視覚化を終了します。ウィンドウが閉じます。 

前のビューに戻る場合は「Back（戻る）」を選択します。 
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3.2 現在のデータの視覚化（ライブビュー） 

3.2.1 可視化 -> 新規  

3.2.1.1 Step 1/4：機器の選択  

手順 1 では、視覚化する機器を選択します。 

 
選択した機器は右側に表示されます。 

後で、選択した機器のリストから機器を削除する場合は、右側のリストの機器を選択し
てからダブルクリックするか、または青色の左矢印をクリックすると、リストから削除
されます。 

機器を選択すると、「Next（次へ）」ボタンが表示されます。このボタンをクリックす
ると、次の手順に移動します。 

「Cancel（キャンセル）」をクリックすると、この処理が終了してウィンドウが閉じ、
プロセスが終了します。 
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3.2.1.2 Step 2/4：チャンネル情報の読み出し  

手順 2 では、ソフトウェアが接続機器のチャンネルを読み出します。読出しプロセスが
完了すると、機器は自動的に手順 3 に進みます。 

 

3.2.1.3 Step 3/4：チャンネルと表示形式の選択  

手順 3 では、チャンネルと表示形式を選択します。 

 

 
最大 40 個のチャンネルまたは最大 100 個のデジタル入力を選択できます。 

チャンネルと表示形式を選択します。表示形式として、測定値曲線、バーグラフ、デジ
タル値を選択できます。 

少なくとも 1 つのチャンネルを選択すると、「Next（次へ）」ボタンが有効になり、ラ
イブ表示に移動できるようになります。 
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3.2.1.4 Step 4/4：現在値の表示（ライブビュー）  

現在値を測定値曲線として表示 

 

現在値をバーグラフとして表示 

 

現在値をデジタル値として表示 
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手順 4 では、選択したチャンネル/入力の現在のデータが表示されます。 

以下のアイコンの機能を使用できます。 

 

 戻る。前の手順に戻ります。 

 次へ。次の手順に進みます。事前に「Back（戻る）」を押した場合にのみ有効にな
ります。 

（ディスク）：表示を保存します。現在の表示をテンプレートとして保存します。テ
ンプレートを開いて修正した場合は、そのテンプレートが新しい設定で上書きされます。 

（ディスクとペン）：名前を付けて保存します。新しいテンプレートを作成して、そ
のテンプレートに新しい名前を割り当てます。 

（Adobe Acrobat® アイコン）：PDF ファイルとしてエクスポートします。現在の 
ビューを PDF としてエクスポートします（グラフ表示の場合のみ）。 

 （バーグラフ）：チャート設定を変更します。 
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 更新レートの設定 

 
個々のチャンネルの設定：色、領域 

（折れ線グラフのリセット）。測定値曲線をリセットします（測定値曲線ビューの
場合のみ）。 

（ピン）：値カーソルの有効/無効を切り替えます（測定値曲線ビューの場合のみ）。
カーソルをグラフの上に移動させると、カーソルの位置に応じて、グラフの下に表示さ
れる値が自動的に更新されます。マウスの左ボタンを押すと、「Values（値）」領域と
「Events（イベント）」領域に表示される値も更新されます。 

（青矢印付き四角形）：グラフの最大化/最小化 

 

「Back（戻る）」ボタンを押すと、もう一度チャンネル選択を呼び出して変更すること
ができます。 

手順 3 で選択したすべてのチャンネルが、ウィンドウの右側のセクションに表示されま
す。チェックボックスのオン/オフによって、チャンネルの表示/非表示を切り替えるこ
とができます。 
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3.3 Visualization -> Open（可視化 -> 開く） 

3.3.1 Step 1/4：テンプレートの選択 

手順 1 では、視覚化するデータのテンプレートを選択できます。 

 
テンプレートを選択すると、「Next（次へ）」ボタンが表示されます。保存データ用の
テンプレートがある場合は、そのまま手順 3 に移動できます。現在のデータ用のテンプ
レートがある場合は、すぐに測定値表示が開始されます。 

 
エッセンシャルバージョンでは、テンプレートにこのソフトウェアバージョンがサポー
トする機器のデータが含まれている場合にのみ、テンプレートを選択して開くことがで
きます。複数の機器のデータを使用するテンプレートを開くことはできません。 

「Cancel（キャンセル）」をクリックすると、この処理が終了してウィンドウが閉じ、
プロセスが中止されます。 

 

3.3.2  Step 2/4：チャンネルの選択 

ソース機器のレポートとチャンネルが、選択したテンプレートにすでに保存されている
場合、Step 2 は自動的に省略されます。 
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3.3.3 Step 3/4：タイムスロットまたはバッチの選択 

この手順は、保存データを視覚化する場合にのみ行います。現在の測定値の表示用テン
プレートがある場合、この手順は省略されます。 

手順 3 では、視覚化するデータのタイムスロット（またはバッチ（使用可能な場合））
を選択します。 

 
視覚化するデータのタイムスロットを少なくとも 1 つ選択すると、「Next（次へ）」を
使用して次の手順に進むことができます。 

 
同一の時間範囲を最大 3 つ選択できるため、相互に比較することができます。 

「Cancel（キャンセル）」をクリックすると、この処理が終了してウィンドウが閉じ、
プロセスが中止されます。 

前のビューに戻る場合は「Back（戻る）」を選択します。 

 

3.3.4 Step 4/4：グラフ 

Step 4 では、選択したタイムスロットまたは生データのグラフ、値、イベントが表示さ
れます（詳細については、セクション 3.1.1.4 または 3.2.1.4 を参照）。 
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3.4 Visualization -> Edit template（可視化 -> テンプレートの編集） 

3.4.1 Step 1/4：テンプレートの選択  

ここでは、保存済みのテンプレートを編集できます。 

 
テンプレートを選択して右クリックすると、選択したテンプレートの削除や名称変更を
行うことができます。 

テンプレートの選択後、「Edit（編集）」を使用して次の手順に移動し、テンプレート
を編集できます。 

 
エッセンシャルバージョンでは、テンプレートにこのソフトウェアバージョンがサポー
トする機器のデータが含まれている場合にのみ、テンプレートを選択して編集すること
ができます。複数の機器のデータを使用するテンプレートを編集することはできません。 

「Close（閉じる）」を選択してプロセスを終了します。ウィンドウが閉じます。 
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3.4.2 Step 2/4：機器の選択  

手順 2 では、ソース機器を選択します。作業ウィンドウの左側に、プラントビューが表
示されます（セクション 4.1 Data management -> Plant view（データ管理 -> プラント
ビュー）を参照）。このビューには、データの視覚化が可能なすべての機器が表示され
ます。 

作業ウィンドウの右側には、視覚化用テンプレートに保存されている機器が表示されます。 

 
プラントビューの機器にチェックマークを入れて、表示される青色の矢印をクリックま
たはダブルクリックすることで、視覚化する機器を選択できます。 

後で、リストから機器を削除する場合は、右側のリストの機器を選択してからダブルク
リックするか、または青色の左矢印をクリックすると、リストから削除されます。 

 
エッセンシャルバージョンでは、サポートされる機器のみを選択できます。 
複数の機器を選択することはできません。 

少なくとも 1 台の機器を選択すると、「Next（次へ）」ボタンが表示されます。このボ
タンをクリックすると、次の手順に移動します。 

「Cancel（キャンセル）」をクリックすると、この処理が終了してウィンドウが閉じ、
プロセスが中止されます。 
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3.4.3 Step 3/4：チャンネルの選択  

手順 3 では、レポートとチャンネルを選択します。 

 
機能： 

Trend（トレンド）： 
Measurement values（測定値）：選択した機器の瞬時値（アナログ値）を選択できます。 

Reports（レポート）： 
選択した機器のレポートを選択できます（日次、週次、月次、外部など）（これらのレ
ポートが機器に保存されている場合にのみ選択可能）。 

Channels（チャンネル）： 
機器説明/TAG、Device type（機器タイプ）：ここには、選択した機器に関する情報が表
示されます。 
Min（最小）、Max（最大）、Average（平均）、Instantaneous（瞬時値）：機器のアナ
ログ値を選択します。 
Status（ステータス）：機器のデジタル値を選択します。 

 

視覚化するデータのレポートとチャンネルを選択してから「更新」を選択すると、選択
したテンプレートが上書きされます。 

「Cancel（キャンセル）」をクリックすると、この処理が終了してウィンドウが閉じ、
プロセスが中止されます。 

前のビューに戻る場合は「Back（戻る）」を選択します。 
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3.4.4 Step 4/4：テンプレートの更新 

手順 4 では、手順 1 で選択したテンプレートを更新します。 

進捗バーに進捗状況が % 単位で示され、推定の残り時間が表示されます。 
処理が完了すると、進捗バーの下に確認メッセージが表示されます。 

 
その他のテンプレートを修正するには、「step 1」を選択して手順 1 に戻ります。 

「Close（閉じる）」を選択してプロセスを終了します。ウィンドウが閉じます。 
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4. Task pane -> Data management（タスクペイン -> データ管理） 

「Data management（データ管理）」タスクには、データおよび機器の管理に関連する
すべての機能が含まれます。 

データはインポートすることによって管理します（例：*.csv、*.xls などの保護なしの 
形式、*.fdm などの保護付きの形式）。データベースからデータを移動させて、データ
ベース容量を低減することもできます。 

機器の管理は主にプラントビュー（使用可能なすべての機器が表示されるツリー構造）
で行います。 

4.1 Data management -> Plant view（データ管理 -> プラントビュー）  

「Data management -> Plant view（データ管理 -> プラントビュー）」タスクを使用して、
プラントビューを開くことができます。 

機器を作成するには、エンタープライズが必要となります（初期設定として定義済み）。
エンタープライズ全体をサイト、エリア、プロセスセル、ユニットに分割できます。 

この分割により、ツリー構造に複数のノードが生成されます。各ノードには複数の機器
を割り当てることができます。 

 

 エッセンシャルバージョンでは、一部の機器がサポートされていません。ノー
ドに割り当てることができるのは、このソフトウェアバージョンがサポートする機器の
みです。 
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プラントビューのメインツールバーには、以下のオプションが用意されています。 

 
• 「プラス」：新しいノードを追加します。つまり、エンタープライズの構造をさ

らに分割します。階層は次のようになります：エンタープライズ、サイト、エリア、
プロセスセル、ユニット。これらのノードに機器を割り当てることができます。こ
れらの機器ノードに対して、名称変更、削除、他のプラント領域（他の上位ノー
ド）への移動を行うことができます。 

• 「X」：選択したノード、機器、データをデータベースから削除します。機器
データを削除する場合は、次のように時間範囲を選択できます。 
 

 
 

 
ノードを削除すると、すべてのデータと一緒に、割り当てられている関連サブノー
ドと、これらのノードに割り当てられている機器が削除されます。 

• 「はさみ」：選択したノードを切り取り、クリップボードにコピーします。次に、
プラントビュー内の別の場所に貼り付けることで、ノードを再び挿入できます。 

• 「クリップボード」：事前にクリップボードにコピーされたノードを貼り付け
ます。 

• （メモ帳とペン）：選択したノードの名前を変更します。 

• 「リング」：データをマージします（セクション 4.1.1 を参照）。 
• （矢印付きボックス）：（FieldCare などから）既存のプラントビュー/機器ツリー

をインポートします（セクション 1.9 を参照）。 

• 「レンチ」：選択した機器の通信設定を開きます（セクション 6.1 を参照）。 
• 「2 つの矢印」：データベースからプラントビューを読み込みます。この機能は

プラントビューを更新する場合に必要となります（例：初回の読出しプロセスでの
機器の新規作成後）。 

上記のオプション（ノードの作成、削除、名称変更、 データのマージ など）は、右ク
リック操作で表示されるコンテキストメニューでも使用できます。 
 
新しい機器の作成： 

新しい機器の読出しプロセスにより、プラントビューに新しい機器ノードが作成されま
す。読出しは、インターフェイスまたは記憶媒体を使用して行うことができます（セク
ション 2 を参照）。読出しの実行時にはデータが分析されます。読み出す機器がすでに
データベースに保存されている場合（シリアル番号および機器名称/タグ、同じ機器設定
が含まれる場合）、データは自動的に対応する機器ノード、つまり既知の機器に割り当
てられます。読み出す機器のシリアル番号または機器名称/タグ が異なる場合は、自動
的に新しい機器ノードが作成されます。シリアル番号と機器名称/タグが同じであっても、
前回と現在の読出しプロセス間で設定が変更されている場合は、既存の機器ノードの下
位のデータに対して、新しい設定ノードが作成されます。読み出すデータは、この新し
い設定ノードに割り当てられます。 
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既存のプラントビュー/既存の機器ツリーのインポート： 

レポート生成ソフトウェアでは、別のプログラムで保存した既存の機器ツリーや既存の
プラントビューを利用できます。この機能は「Data Management -> Plant View（データ
管理 -> プラントビュー）」タスクで使用できます。 

「矢印付きボックス」  アイコンを押すと、コンピュータのディレクトリ構造が表示
されます。保存場所を選択し、対応するプラントビューの CSV ファイルを選択します。
これにより、ツリー構造がデータベースに読み込まれて保存されます。エンタープライ
ズを選択して右クリックし、「Import Plant View（プラントビューのインポート）」を
選択しても同じ機能を使用できます。 

 

機器の設定： 

プラントビューの設定メニューを使用すると、対応する機器に直接割り当てられる設定
を定義できます。 

これを行うには、対応する機器を選択してから、「レンチ」アイコン  をクリックす
るか、または右クリックで表示されるコンテキストメニューから「Change Settings（設
定の変更）」を選択して、設定ウィンドウを開きます。詳細については、セクション 6 
を参照してください。 

 

4.1.1 設定のマージ  

読み出された個々の機器は、機器名称/タグおよびシリアル番号を使用してレポート生成
ソフトウェアで識別されます。また、チャンネルの設定も評価されます。 
読み出したデータを（シリアル番号と機器名称/タグを使用して）機器に明確に割り当て
ることができるものの、読み出した機器データの設定が、保存されている機器設定と一
致しない場合は、機器ノードの下に新しい設定が作成されます。 
このような状況は、たとえば、機器の設定が変更された場合（チャンネルのオフ、チャ
ンネルのユニット変更など）や、測定点と設定が異なるポータブル型の計測機器として
機器が使用された場合などに発生します。 

設定が異なる場合でもデータをマージしてデータベースの運用を継続し、分析を継続す
る場合は、「Merging configurations（設定のマージ）」機能を使用します。 

マージを行うと、測定データは常に最新の設定に割り当てられます。 

「Data Management -> Plant View（データ管理 -> プラントビュー）」タスク（セクショ
ン 4.1 を参照）で、プラントビューの設定を選択します。この選択した設定は別の設定の
データに割り当てられます。つまり、選択した設定は変更されません。「リング」アイ
コン  をクリックするか、または右クリックして表示されるコンテキストメニューから
「Merging configurations（設定のマージ）」をクリックすると、新しいダイアログウィ
ンドウが表示されます。 
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4.1.1.1 Step 1/2：設定の選択  

左側には、データベースで使用可能な機器およびその機器に割り当てられている設定が
表示されます。 
設定をダブルクリックして設定を選択し、2 つのボックスの中央にある右矢印をクリッ
クするか、またはマウスのドラッグアンドドロップ操作により、マージする設定を右側
に移動できます。 

右側のボックス内のこれらの設定の全データが、プラントビューで選択した設定および
対応する機器にマージされて割り当てられます。 

 

 
機器および機器設定をマージした後に、これを取り消すことはできません。 

「Next（次へ）」ボタンまたはメインツールバーの緑色の矢印を押して、手順 2 に移動
し、設定をマージします。 
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4.1.1.2 Step 2/2：マージ  
設定をマージできるのは、マージ処理によってデータ損失が発生しない場合のみです。
例：機器は 2 つの設定を備えており、 古い方の設定では 2 つのチャンネルが有効でした
が、新しい方の設定では 1 つのチャンネルがオフになっています。マージを行うと、す
べてのデータが最新（新しい方）の設定に割り当てられます。この例では、1 つのチャ
ンネルのみが有効になります。したがって、もう 1 つのチャンネルのデータにはアクセ
スできなくなります。このため、この例では設定をマージすることはできません。この
ような場合にはメッセージが表示されます。 
ただし、設定をマージするかどうかをユーザーが指定できる場合もあります。たとえば、
チャンネルのユニットを変更する場合や、チャンネルを平均から最小に切り替える場合
などです。この場合には、次のようなメッセージが表示されます。 

 
適切なボタンを選択して、設定をマージするか、またはマージをキャンセルします。 

進捗バーに進捗状況が % 単位で示され、推定の残り時間が表示されます。この手順の実
行中に処理を中止する場合は「Cancel（キャンセル）」ボタンを押します。前のビュー
に戻る場合は「Back（戻る）」を選択します。 

処理が完了すると、進捗バーの下に確認メッセージが表示されます。 

 
「Close（閉じる）」を選択してプロセスを終了します。ウィンドウが閉じます。 
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4.1.2 機器のマージ  

読み出された個々の機器は、機器名称/タグおよびシリアル番号を使用してレポート生成
ソフトウェアで識別されます。 

これらが一致しない機器は、プラントビューで個別の機器として作成されます。 

機器/スペア機器の交換時には、シリアル番号が異なる場合でもデータをマージするよう
求めるメッセージが表示され、データベースの運用を継続して、分析を継続することが
できます。「Merge devices（機器のマージ）」機能を使用すると、これを実現できます。 

「Data Management -> Plant View（データ管理 -> プラントビュー）」タスク（セクショ
ン 4.1 を参照）のプラントビューで、マージする機器を 1 つ選択できます。選択した機器
が変更されることはなく、今後、機器のすべてのデータは、この選択した機器にマージ

され、割り当てられます。  アイコンをクリックするか、または右クリックして表示さ
れるコンテキストメニューから「Merge Devices（機器のマージ）」をクリックすると、
新しいダイアログウィンドウが表示されます。 

4.1.2.1 Step 1/2：機器の選択  

左側には、データベースで使用可能な機器が表示されます。 
機器をダブルクリックして機器を選択し、2 つのボックスの中央にある右矢印をクリッ
クするか、またはマウスのドラッグアンドドロップ操作により、マージする機器を右側
に移動できます。 
右側のボックス内のこれらの機器の全データが、プラントビューで選択した機器にマー
ジされて割り当てられます。 

 
「Next（次へ）」ボタンまたはメインツールバーの緑色の矢印を押して、手順 2 に移動
し、機器のデータをマージします。 
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4.1.2.2 Step 2/2：結果：機器のマージ  

進捗バーに進捗状況が % 単位で示され、推定の残り時間が表示されます。この手順の実
行中に処理を中止する場合は「Cancel（キャンセル）」ボタンを押します。前のビュー
に戻る場合は「Back（戻る）」を選択します。 

機器とそのデータのマージ処理が正常に完了すると、進捗バーの下に確認メッセージが
表示されます。 

 

 
機器をマージした後に、これを取り消すことはできません。 

「Close（閉じる）」を選択してプロセスを終了します。ウィンドウが閉じます。 

4.2 Data management -> Export（データ管理 -> エクスポート） 

データベースに保存されているデータをエクスポートできます。 
これには、以下のようなさまざまなオプションが用意されています。 

- 保護付きの形式（バイナリファイル *.fdm）での改ざん防止機能付きエクスポート 

- 保護のない形式（Excel / CSV）へのエクスポート 

データを保護付きの形式でエクスポートした場合、そのデータを改ざんすることはでき
ません。これにより、データの改ざんを防止しながら、データを安全に移動させてデー
タベースのデータ容量を削減することや、データを別のデータベースや別のユーザーに
転送することができます。 
保護付き形式のデータをレポート生成ソフトウェアに再び読み込んだ場合、元のデータ
と同じデータとして処理されます。 
Excel または CSV 形式で保存されたデータは、手動データとして識別されます。 

エクスポートの種類は、最初の手順で選択するファイルタイプ/形式によって決まります。 
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4.2.1 保護付きの形式（バイナリファイル、*.fdm）でのエクスポート  

データをエクスポートするには、「Data management -> Export（データ管理 –> エクス
ポート）」でエクスポート機能を使用します。保護付き形式でのエクスポートは、6 つ
の手順で行います。 

4.2.1.1 Step 1：エクスポート形式の選択 

｢バイナリファイル (*.fdm)｣、｢Excel (*.xls)｣、｢CSV ファイル (*.csv)｣、｢エネルギーモニ
タリングファイル用 CSV (*.csv)」から選択できます。 

保護付き形式でエクスポートする場合は、「バイナリファイル (*.fdm)」を選択します。 

 
エネルギー監視用エクスポートに関する注意： 

エネルギー監視用のデータは、特別に調整されたプロパティを持つ保護のない形式
（*.csv）でエクスポートされます（列の制限、日付と時刻の形式が初期設定されていま
す）。評価ソフトウェアの測定値をエネルギー監視用ソフトウェアにインポートする場
合は、インポート用コードを入力する必要があります。インポート用コードは、<チャン
ネル名>-<タイプ> で構成されます（各列の最初の 2 つのセルの組合せ）。 
例：「Analog 1-average」、「Analog 2-」 

「エネルギーモニタリングファイル用 CSV (*.csv)」のエクスポートは、 
エッセンシャルバージョンではサポートされていません。 

「Next（次へ）」ボタンまたはメインツールバーの緑色の矢印を押すと、次の手順に移
動します。 
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4.2.1.2 Step 2/6：機器の選択 

左側には、データベースで使用可能な機器が表示されます。 

機器をダブルクリックして機器を選択し、2 つのボックスの中央にある右矢印をクリッ
クするか、またはマウスのドラッグアンドドロップ操作により、エクスポートする機器
を右側に移動できます。 

右側の機器のデータをエクスポートできます。 

 
「Next（次へ）」ボタンまたはメインツールバーの緑色の矢印を押すと、次の手順に移
動します。 

 

4.2.1.3 Step 3/6：タイムスロットの選択  

ドロップダウンリストを使用して時間範囲を指定できます。選択した機器のすべての保
存データのうち、この時間範囲内に存在するデータがすべてエクスポートされます。 

 
「Next（次へ）」ボタンまたはメインツールバーの緑色の矢印を押すと、次の手順に移
動します。 
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4.2.1.4 Step 4/6：ファイル名とファイルサイズの選択  

Output File（ファイル出力）： 
File name（ファイル名）：ここでは保存場所を指定できます。「...」ボタンをクリック
すると、コンピュータのディレクトリ構造が表示され、エクスポート用の保存場所を選
択できます。 

Maximum file size（最大ファイルサイズ）：エクスポートファイルのサイズに制限を設
ける場合、または対象の保存場所である媒体（DVD、CD など）に合わせてファイルサイ
ズを調整する場合は、ドロップダウンリストを使用して、対象の媒体を選択できます。 

 
その下には、さらに 2 つの機能が用意されています。 

Repeat export periodically（定期的にエクスポートの繰り返し）： 
保護付き形式でデータの自動エクスポートおよび自動保存を行います。このチェックボッ
クスをオンにすると、エクスポート用の自動機能が有効になります。 

Delete data after export was successful（エクスポート成功後のデータ削除）： 
このチェックボックスをオンにすると、正常にエクスポートされたデータがデータベー
スから削除されます。つまり、データベースではそのデータを使用できなくなりますが、
これは保護付きのエクスポートファイルとして使用する場合に限定されます。 

 
データベースからデータを削除した後に、これを取り消すことはできません。後からデー
タをレポートや視覚化に利用する場合は、保護付き形式でエクスポートされたデータをレ
ポート生成ソフトウェアに再びインポートする必要があります。 

 

「Next（次へ）」ボタンまたはメインツールバーの緑色の矢印を押すと、次の手順に移
動します。 
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4.2.1.5 Step 5/6：自動設定  

 
これは、前の手順で「Repeat export periodically（定期的にエクスポートを繰り返す）」
を選択した場合にのみ表示されます。 

 

Data backup（データバックアップ）： 
ここでは自動エクスポートの周期を指定します。このために「Active（有効）」チェッ
クボックスを選択する必要があります。 

Interval（間隔）：エクスポートを実行する頻度。 
選択した周期に応じて、開始日、開始時間などの繰返しに関するデータを指定します。 

Data time period（データの時間範囲）：エクスポートの時間範囲を選択します。これは、
指定した時点のエクスポートに、選択した時間範囲のデータ（エクスポートの開始日/開
始時刻から遡った時間範囲のデータ）が含まれることを意味します（セクション 6.6 を
参照）。 

File path（ファイルパス）：ネットワークドライブを選択した場合は、ユーザー名とパ
スワードの入力も求められます。その設定は保存され、「Extras -> Settings -> 
Automatic（その他 -> 設定 -> 自動）」で変更できます（セクション 5.1.6 を参照）。 

 
自動機能でネットワークドライブにアクセスできるようにするには、自動サービス用の
ログオン情報を変更する必要があります（セクション 5.1.6 を参照）。 
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Data elimination（データ消去）： 

 
データベースからデータを削除した後に、これを取り消すことはできません。データベー
スからデータを削除する場合、そのデータが本当に不要であるかどうかを確認してくださ
い。あるいは、必要に応じてデータを後から利用できるように、データを保護付きエクス
ポートで別の保存場所に保存しておいてください。 

ここでは、データベースからデータを削除するための自動機能を設定します。「Active
（有効）」チェックボックスを選択すると、エクスポートされたデータはデータベース
から削除され、復元することはできません（セクション 6.4 を参照）。 

 
「Next（次へ）」ボタンを使用して確定する前に、選択内容を確認してください。 
データを削除しても問題はありませんか？自動エクスポート機能と自動削除の設定に重
複はありませんか？保護付き形式でのエクスポートの前に、データが削除されないこと
を確認しましたか？ 

「Next（次へ）」ボタンまたはメインツールバーの緑色の矢印を押すと、次の手順に移
動し、エクスポートが開始され、データが削除されて自動機能（選択した場合）が開始
されます。 

 

4.2.1.6 Step 6/6：データのエクスポート  

進捗バーに進捗状況が % 単位で示され、推定の残り時間が表示されます。この手順の実
行中に処理を中止する場合は「Cancel（キャンセル）」ボタンを押します。前のビュー
に戻る場合は「Back（戻る）」を選択します。 

データのエクスポートが正常に完了すると、進捗バーの下に確認メッセージが表示され
ます。 

 
「Close（閉じる）」を選択してプロセスを終了します。ウィンドウが閉じます。 
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4.2.2 保護のない形式（Excel/CSV、エネルギーモニタリングファイル）でのエクスポート 

データをエクスポートするには、「Data Management –> Export（データ管理 –> エクス
ポート）」でエクスポート機能を使用します。保護のない形式（Excel/CSV）へのエクス
ポートは、8 つの手順で行います。 

 

4.2.2.1 Step 1/8：エクスポート形式の選択 

「Excel (*.xls)」、「CSV files（CSV ファイル） (*.csv)」、「CSV for energy monitoring 
files（エネルギーモニタリングファイル用 CSV） (*.csv)」から選択できます。 

 
エネルギー監視用エクスポートに関する注意： 

エネルギー監視用のデータは、特別に調整されたプロパティを持つ保護のない形式
（*.csv）でエクスポートされます（列の制限、日付と時刻の形式が初期設定されていま
す）。評価ソフトウェアの測定値をエネルギー監視用ソフトウェアにインポートする場
合は、インポート用コードを入力する必要があります。インポート用コードは、<チャン
ネル名>-<タイプ> で構成されます（各列の最初の 2 つのセルの組合せ）。 
例：「Analog 1-average」、「Analog 2-」 

「CSV for energy monitoring files（エネルギーモニタリングファイル用 CSV） 
(*.csv)」のエクスポートは、エッセンシャルバージョンではサポートされていません。 

「Next（次へ）」ボタンまたはメインツールバーの緑色の矢印を押すと、次の手順に移
動します。 
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4.2.2.2 Step 2/8：テンプレートの使用方法を選択  

ここでは、エクスポートするデータを選択できます。 

 

Don't use templates（テンプレートを使わない）： 
後続の手順で選択する機器とチャンネルをエクスポートにのみ適用する必要があり、定
義するレポートがその他の自動処理（自動視覚化/自動印刷）には不要な場合、ここで
「Don't Use Templates（テンプレートを使わない）」オプションを選択できます。 

Create new template（新規テンプレートの作成）： 
新しいテンプレートを定義する場合、ここで「Create new template（新規テンプレート
の作成）：」オプションを選択できます。この場合、そのテンプレートを今後の視覚化
処理にも利用できます。テンプレートは、機器とチャンネルがあらかじめ選択されてい
る事前定義済みのレポートです。 
「Template Name（テンプレート名）」行を使用して、作成するテンプレートに新しい名前
を割り当てることができます。名前を指定しないと、次の手順に進むことはできません。 
すでに割り当てられている名前は使用できません。割当済みの名前を使用した場合、既存
のテンプレートが上書きされます。既存のテンプレートの名前を変更して一意の名前を指
定する場合は、テンプレートを右クリックして「Rename（名前の変更）」を選択します。 

Open Template（テンプレートを開く）：生成するレポートがすでに視覚化として定義
され、テンプレートとして保存されている場合、ここでそのテンプレート（対応する機
器とチャンネルが選択済み）を選択できます。 

エッセンシャルバージョンでは、テンプレートにこのソフトウェアバージョンが
サポートする機器のデータが含まれている場合にのみ、テンプレートを選択することが
できます。複数の機器のデータを含むテンプレートを編集することはできません。 
 
機器またはチャンネルの選択を変更する場合は、「Back（戻る）」ボタンまたはメイン
ツールバーの対応する緑色の矢印アイコンを押します。 

「Next（次へ）」ボタンまたはメインツールバーの緑色の矢印を押すと、次の手順に移
動します。 
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4.2.2.3 Step 3/8：機器の選択  

 
既存のテンプレートを使用する場合、この手順は省略されます。 

左側には、データベースで使用可能な機器およびその機器の設定が表示されます。 
設定をダブルクリックして設定を選択し、2 つのボックスの中央にある右矢印をクリッ
クするか、またはマウスのドラッグアンドドロップ操作により、エクスポートする機器
を右側に移動できます。 
右側の機器のデータをエクスポートできます。 

 

 
エッセンシャルバージョンでは、サポートされる機器のみを選択できます。 
複数の機器を選択することはできません。 

「Next（次へ）」ボタンまたはメインツールバーの緑色の矢印を押すと、次の手順に移
動します。 



Task pane -> Data management（タスクペイン -> データ管理） 

  

76 
 

4.2.2.4 Step 4/8：チャンネルの選択  

 
既存のテンプレートを使用する場合、この手順は省略されます。 

左側には、選択した機器/設定の有効なチャンネルが表示されます。チェックボックスを
選択することで、対応するチャンネルを選択できます。 

設定のチェックボックス（上位のチェックボックス）を選択することで、すべての有効
なチャンネルを選択できます。 

 
機能： 

Trend（トレンド）： 
Measurement values（測定値）：選択した機器の瞬時値（アナログ値）を選択できます。 

Reports（レポート）： 
選択した機器のレポートを選択できます（日次、週次、月次、外部、計測期間など）
（これらのレポートが機器に保存されている場合にのみ選択可能）。 

Channels（チャンネル）： 
機器説明/TAG、機器タイプ：ここには、選択した機器に関する情報が表示されます。 
Min（最小）、Max（最大）、Average（平均）、Instantaneous（瞬時値）：機器のアナ
ログ値を選択します。 
Status（ステータス）：機器のデジタル値を選択します。 

 

「Next（次へ）」ボタンまたはメインツールバーの緑色の矢印を押すと、次の手順に移
動します。 
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4.2.2.5 Step 5/8：タイムスロットまたはバッチの選択  

ドロップダウンリストを使用して時間範囲（またはバッチ（使用可能な場合））を指定
できます。選択した機器のすべての保存データのうち、この時間範囲内に存在するデー
タがすべてエクスポートされます。 

 
「Next（次へ）」ボタンまたはメインツールバーの緑色の矢印を押すと、次の手順に移
動します。 
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4.2.2.6 Step 6/8：ファイル名の選択  

「Output File（ファイル出力）」ボックスでは保存場所を指定できます。「...」ボタン
をクリックすると、コンピュータのディレクトリ構造が表示され、エクスポート用の保
存場所を選択できます。 

Data（データ）：値のみをエクスポートするか、またはイベントもエクスポートするか
を選択します。 

 

Repeat export periodically（定期的にエクスポートの繰り返し）：保護のない形式で
データの自動エクスポートおよび自動保存を行います。このチェックボックスをオン
にすると、エクスポート用の自動機能が有効になります。 

 保護のない形式でのデータの自動エクスポートおよび自動保存機能は、エッ
センシャルバージョンではサポートされていません。 

 
「Repeat export periodically（定期的にエクスポートの繰り返し）」は、テンプレートを
使用する場合にのみ選択できます（手順 2/8 を参照）。 

「Next（次へ）」ボタンまたはメインツールバーの緑色の矢印を押すと、次の手順に移
動します。 
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4.2.2.7 Step 7/8：自動設定  

 
これは、前の手順で「Repeat export periodically（定期的にエクスポートを繰り返す）」
を選択した場合にのみ表示されます。 

「Excel/CSV Export（Excel/CSV エクスポート）」ボックスでは、自動エクスポートの周
期（繰り返す頻度）を指定できます。このために「Active（有効）」チェックボックス
を選択する必要があります。 

Interval（間隔）：エクスポートを実行する頻度。 
選択した周期に応じて、開始日、開始時間などの繰返しに関するデータを指定します
（セクション 6.6 を参照）。 

Data time period（データの時間範囲）：エクスポートの時間範囲を選択します。これは、
指定した時点のエクスポートに、選択した時間範囲のデータ（エクスポートの開始日/開
始時刻を始点として、そこから遡った時間範囲のデータ）が含まれることを意味します。 

Export type（エクスポートタイプ）：値のみをエクスポートするか、またはイベントも
エクスポートするかを選択します。 

File handling（ファイル操作）：新しいエクスポートファイルを作成するか、エクス
ポートファイルを既存のファイルの最後に追加するか、または既存のファイルを上書
きするかを選択します。 

File size（ファイルサイズ）：エクスポートファイルのサイズに制限を設ける場合、また
は保存場所である媒体（DVD、CD など）に合わせてファイルサイズを調整する場合は、
ドロップダウンリストで対象の媒体を選択できます。 

File path（ファイルパス）：ネットワークドライブを選択した場合は、ユーザー名とパ
スワードの入力も求められます。その設定は保存され、「Extras -> Settings -> 
Automatic（その他 -> 設定 -> 自動）」で変更できます（セクション 5.1.6 を参照）。 

 
自動機能でネットワークドライブにアクセスできるようにするには、自動サービス用の
ログオン情報を変更する必要があります（セクション 5.1.6 を参照）。 

 
「Next（次へ）」ボタンまたはメインツールバーの緑色の矢印を押すと、次の手順に移
動し、エクスポートおよび自動機能（選択した場合）が開始されます。 
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4.2.2.8 Step 8/8：データのエクスポート  

進捗バーに進捗状況が % 単位で示され、推定の残り時間が表示されます。この手順の実
行中に処理を中止する場合は「Cancel（キャンセル）」ボタンを押します。前のビュー
に戻る場合は「Back（戻る）」を選択します。 

データのエクスポートが正常に完了すると、進捗バーの下に確認メッセージが表示され
ます。 

 
「Close（閉じる）」を選択してプロセスを終了します。ウィンドウが閉じます。 
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4.3 Data management -> Import（データ管理 -> インポート）  

レポート生成ソフトウェアでは、データをデータベースにインポートできます。 
このデータは、機器やファイルから取得できます。 
これを行う場合、以前に保護付きの *.fdm 形式を使用してエクスポートされたデータ
をインポートすることができます。この形式はデータの改ざんを防止できるため、測
定データの正確性が保証されます。 

rsd 形式を使用して ReadWin 2000 PC ソフトウェアからデータをインポートできます
（セクション 1.10 を参照）。 

 ReadWin 2000 からのデータ転送機能は、エッセンシャルバージョンではサ
ポートされていません。 

Excel（*.xls）からデータをインポートすることや、データを CSV ファイル（*.csv）とし
てインポートすることもできます。これはプランニングデータなどに利用できます。こ
れにより、プランニングデータと実際の測定データを直接比較することができます。 
XLS または CSV 形式でインポートされたデータは、手動データとして識別されます。 

 

Excel（*.xls）または CSV（*.csv）ファイルのインポート形式： 
Excel または CSV を使用して、データをレポート生成ソフトウェアにインポートする場
合、値（測定値、チャンネル名称など）を対応するファイルに入力する必要があります。
タイムスタンプセルの形式が重要です（例：YYYY-MM-dd hh:mm:ss）。 
ISO 8601 では、タイムスタンプセルの形式を考慮する必要があります。ダッシュ「-」
が、日、月、年の区切り文字として定義されています。 

例： 

 
Time format  
(YYYY-MM-dd hh:mm:ss) 

Channel 1 
name 

Channel 2 
name 

Channel 3 
name 

Channel 4 
name … 

 Channel 1 unit Channel 2 unit Channel 3 unit Channel 4 unit … 
2000-11-23 23:48:34 0.0002 0.01 12 2778  
2000-11-23 23:48:35 0.345 0.03 24 56456  
2000-11-23 23:48:36 0.0688 0.05 36 110134  
2000-11-23 23:48:37 0.1031 0.07 48 163812  
2000-11-23 23:48:38 0.1374 0.09 60 217490  
2000-11-23 23:48:39 0.1717 0.11 72 271168  
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4.3.1 Step 1/3：ソースの選択  

「Select File（ファイルの選択）」ボックスでは、データの保存場所を指定できます。
「...」ボタンをクリックすると、コンピュータのディレクトリ構造が表示され、イン
ポートするファイルを選択できます。 

保護付き形式（*.fdm）のファイルを選択した場合、インポートする機器はすでにその形
式で定義されているため、手順 2 は省略されます。 

 
「Next（次へ）」ボタンまたはメインツールバーの緑色の矢印を押すと、次の手順に移
動します。 
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4.3.2 Step 2/3：機器の選択 

プラントビューで機器またはノードを選択します。インポートするデータは、このプラ
ント設備に組織的に割り当てられます。 

 
「Next（次へ）」ボタンまたはメインツールバーの緑色の矢印を押すと、次の手順に移
動し、インポートが開始されます。 
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4.3.3 Step 3/3：データのインポート 

進捗バーに進捗状況が % 単位で示され、推定の残り時間が表示されます。この手順の実
行中に処理を中止する場合は「Cancel（キャンセル）」ボタンを押します。前のビュー
に戻る場合は「Back（戻る）」を選択します。 

データのインポートが正常に完了すると、進捗バーの下に確認メッセージが表示され
ます。 

 
「Close（閉じる）」を選択してプロセスを終了します。ウィンドウが閉じます。 
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4.4 Data management -> Automatic（データ管理 -> 自動）  
自動機能はシステムサービスとして設定され、バックグラウンドで実行されます。自動
機能を有効にするには、レポート生成ソフトウェアの最初のインストール時に自動コン
ポーネントをインストールする必要があります。自動コンポーネントをインストールす

ると、  アイコンがウィンドウの右下に表示されます。このアイ
コンが表示されていない場合は、コンポーネントをインストールする必要があります。
これはインストール用 DVD に収められています（1.5 章を参照）。 

 エッセンシャルバージョンでサポートされている機能は、データの自動読出し、
読出完了後の機器データの自動削除、および自動バイナリエクスポートのみです。
「Automatic XLS/CSV export（自動 XLS/CSV エクスポート）」、「Automatic PDF export
（自動 PDF 出力）」、および「Automatic print out（自動印刷）」機能は、このソフト
ウェアバージョンでは使用できません。 
 

4.4.1 自動情報：現在の概要  
すべての自動機能は、「Data Management –> Automatic（データ管理 –> 自動）」タス
クで設定します。また、このタスクでは、有効/無効のすべての自動プロセスの概要も表
示されます。 

 
各手順で定義される自動機能は現在有効であり、ここで説明される一元管理タスクを使
用して管理することもできます。 
 

4.4.1.1 Step 1/3：ジョブタイプの選択  

 

Automatic information（自動情報）：必要な情報を選択します。 
オプション：Current overview（現在の概要）、Event view（イベントビュー）、
Automatic new/edit（自動機能の新規作成/編集）。 

「Next（次へ）」ボタンまたはメインツールバーの緑色の矢印を押すと、次の手順に移
動します。 
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4.4.1.2 Step 2/3：テンプレートまたは機器の選択  

自動タスクの概要の選択には不要なため、Step 2 は自動的に省略されます。 

4.4.1.3 Step 3/3：自動運転の概要  

手順 3 では、すべての自動タスクの概要が表示されます。 

 
ここで個々の自動タスクの有効/無効を切り替えることができます。 

色分け： 
オレンジ：自動タスクは無効です。 
白：自動タスクは有効であり、実行する準備が整っています。 
緑：現在、自動タスクの実行中です。 
青：自動タスクが選択されています。ツールバーの「X」をクリックすると、これを削
除できます。 

赤：自動サービスのステータスが不明です（エラー、例：自動機能のアンインストール
後など） 

「Close（閉じる）」を選択してプロセスを終了します。ウィンドウが閉じます。 
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4.4.2 自動情報：イベントビュー  

すべての自動機能は、「Data Management –> Automatic（データ管理 –> 自動）」タス
クで設定します。また、このタスクでは、有効/無効のすべての自動プロセスの概要も表
示されます。 

 
各手順で定義される自動機能は現在有効であり、ここで説明される一元管理タスクを使
用して管理することもできます。 

 

4.4.2.1 Step 1/3：ジョブタイプの選択  

 

Automatic information（自動情報）：必要な情報を選択します。 
オプション：Current overview（現在の概要）、Event view（イベントビュー）、
Automatic new/edit（自動機能の新規作成/編集）。 

 

「Next（次へ）」ボタンまたはメインツールバーの緑色の矢印を押すと、次の手順に移
動します。 

 

4.4.2.2 Step 2/3：テンプレートまたは機器の選択  

イベント概要の選択には不要なため、Step 2 は自動的に省略されます。 
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4.4.2.3 Step 3/3：自動でイベントを把握  
手順 3 では、すべての自動タスクのイベント概要が表示されます。 

 
「Close（閉じる）」を選択してプロセスを終了します。ウィンドウが閉じます。 
 

4.4.3 自動機能の新規作成/編集  
すべての自動機能は、「Data Management –> Automatic（データ管理 –> 自動）」タス
クで設定します。 

 
各手順で定義される自動機能は現在有効であり、ここで説明される一元管理タスクを使
用して管理することもできます。 
 

4.4.3.1 Step 1/3：ジョブタイプの選択  

 
Automatic information（自動情報）：必要な情報を選択します。 
オプション：Current overview（現在の概要）、Event view（イベントビュー）、
Automatic new/edit（自動機能の新規作成/編集）。 
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タスクを選択（「Automatic new/edit（自動機能の新規作成/編集）」を選択した場合に
のみ使用可能）： 

Read out device（機器の読み出し）：フィールド機器に保存されているデータを自動的
にデータベースに保存します。 

Binary export（バイナリエクスポート）：データベースから保護付きデータをエクス
ポートする場合に使用します（例：SQL サーバーの容量削減のためなどに行います）。 

Time synchronize（時刻の同期）：定期的な自動時刻同期用（機器の時刻とシステム時
間を同期させます）。 

Delete data（データの削除）：データベースからデータを自動的に削除できます。 

 
データベースからデータを削除した後に、これを取り消すことはできません。 

Print out template（テンプレートを印刷）：一定の周期で視覚化用テンプレートを自動
的に印刷できます（定義されたレポート/視覚化はテンプレートとして保存され、一定の
周期で自動的に再生成されて印刷されます）。 

XLS/CSV export（XLS/CSV エクスポート）：一定の周期でデータを XLS または CSV 形式
で自動的にエクスポートできます。この場合、テンプレートも選択する必要があります
（定義されたレポートはテンプレートとして保存され、一定の周期で自動的に再生成さ
れてエクスポートされます）。 

PDF export（PDF 出力）：一定の周期でデータを PDF 形式で自動的にエクスポートでき
ます。この場合、テンプレートも選択する必要があります（定義されたレポートはテン
プレートとして保存され、一定の周期で自動的に再生成されてエクスポートされます）。 

PDF export (multiple templates)（PDF 出力（複数のテンプレート））：一定の周期で複
数のテンプレートを PDF 形式で自動的にエクスポートできます。 

Web export（Web エクスポート）：Endress+Hauser のミドルウェアを使用して、データ
を他のシステムに自動的にエクスポートできます。この場合、テンプレートも選択する
必要があります（定義されたレポートはテンプレートとして保存され、そのデータは一
定の周期で自動的にミドルウェアに送信されます）。 

Certification PDF export（証明書の PDF 出力）：Memograph M RSG45 システム
（TrustSens 校正監視）に記録されている iTHERM TrustSens 校正証明書を一定の周期で
自動的にエクスポートできます。 

  
エッセンシャルバージョンでサポートされている機能は、データの自動読出し、読出完
了後の機器データの自動削除、および自動バイナリエクスポートのみです。「Automatic 
XLS/CSV export（自動 XLS/CSV エクスポート）」、「Automatic PDF export（自動 PDF 
出力）」、および「Automatic print out（自動印刷）」機能は、このソフトウェアバー
ジョンでは使用できません。 

「Next（次へ）」ボタンまたはメインツールバーの緑色の矢印を押すと、次の手順に移
動します。 
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4.4.3.2 Step 2/3：テンプレートまたは機器の選択  

 
手順 1 で「Automatic new/edit（自動機能の新規作成/編集）」を選択した場合にのみ実
行できます。 

手順 2 では、適切なテンプレートまたは読出しを行う機器を選択する必要があります。 

 

 
 

「Next（次へ）」ボタンまたはメインツールバーの緑色の矢印を押すと、次の手順に移
動します。 
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4.4.3.3 Step 3/3：自動機能の設定 

 
手順 1 で「Automatic new/edit（自動機能の新規作成/編集）」を選択した場合にのみ実
行できます。 

手順 3 では、頻度を指定します。このために「Active（有効）」チェックボックスを選
択する必要があります。 

 
間隔を使用して頻度を定義し、開始時刻を指定できます（セクション 6.6 を参照）。 

自動タスクが「Delete Data（データの削除）」、「Create PDF（PDF の作成）」、
「CSV Export（CSV エクスポート）」、「XLS Export（XLS エクスポート）」、「Binary 
Export（バイナリエクスポート）」（保護付き形式）の場合、データの時間範囲も指定
する必要があります。 

File handling（ファイル操作）（Excel/CSV エクスポート の場合）：新しいエクスポー
トファイルを作成するか、エクスポートファイルを既存のファイルの最後に追加するか、
または既存のファイルを上書きするかを選択します。 

File size（ファイルサイズ）（Excel/CSV エクスポートの場合）：エクスポートファイル
のサイズに制限を設ける場合、または保存場所である媒体（DVD、CD など）に合わせて
ファイルサイズを調整する場合は、ドロップダウンリストで対象の媒体を選択できます。 

File path（ファイルパス）：すべてのエクスポートの自動タスクでは、エクスポートす
るデータレポートの場所を指定する必要があります。「...」ボタンをクリックすると、
Explorer が開きます。 
ネットワークドライブを選択した場合は、ユーザー名とパスワードの入力も求められま
す。その設定は保存され、「Extras -> Settings -> Automatic（その他 -> 設定 -> 自
動）」で変更できます（セクション 5.1.6 を参照）。 
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自動機能でネットワークドライブにアクセスできるようにするには、自動サービス用の
ログオン情報を変更する必要があります（セクション 5.1.6 を参照）。 

Timeout (s)（タイムアウト（秒））（Web エクスポートの場合）：ミドルウェアへの
データ転送のタイムアウト。 
User name / password（ユーザー名/パスワード）（Web エクスポートの場合）：ミドル
ウェアで設定されているユーザー。 
Web URL（Web エクスポートの場合）：ミドルウェアの Web アドレス。 
Certificate（証明書）（Web エクスポートの場合）：ミドルウェアとの通信に https（暗
号化接続）を使用する場合、対応する証明書を自動サービスで永続的に利用できるよう
にする必要があります。 
Connection test（接続テスト）（Web エクスポートの場合）：ミドルウェアとの接続を
テストします。 

「Save（保存）」をクリックすると、設定が有効になり保存されて、設定が完了します。 
「Close（閉じる）」を選択してプロセスを終了します。ウィンドウが閉じます。 
 

4.4.4 自動サービス  

システムサービスの自動シンボル  が、レポート生成ソフトウェ
アの右下隅に表示されます。システムサービスは、さまざまな状態 （保留、一時停止、
停止、インストールされていない、無効、未定義ステータス、無効）を示します。 

各状態の説明： 

– 「Pending（保留）」：現在、サービスはロックされており、有効化されるまで待
機状態です。この状態が 2 分以内に変化しない場合は、システム管理者に通知して
システムサービスを再起動してください。 

– 「Stopped（停止）」、「Paused（一時停止）」、「Ended（終了）」：現在、サー
ビスは稼働していません。この状態は、システム管理者がサービスを中断した場合
に発生します。 

– 「Not Installed（インストールされていない）」：レポート生成ソフトウェアは、
自動サービス/自動コンポーネントがなくてもインストールできます。この場合、す
べての自動設定が無効になります。後から自動コンポーネントをインストールする
場合は、（初回インストール時と同様に）設定ルーチンを使用してインストールし
てください。設定ルーチンでは「Install Automatic Component（自動コンポーネン
トのインストール）」オプションを選択する（オンにする）必要があります（セク
ション 1.5 を参照）。 

– 「Inactive（無効）」：トレイアイコンのメニュー（セクション 4.4.6 を参照）で、
所定の自動ジョブの内部状態に対して、その有効/無効を切り替えることができます。 

– 「Active（有効）」：Windows システムサービス/自動機能が有効であり稼働中です。 

– 「Undefined Status（未定義ステータス）」：この状態は、データベース接続が利
用不可である、遮断されている、またはサービスが未定義状態の場合に表示される
可能性があります。レポート生成ソフトウェアとすべての自動コンポーネントを終
了してから再起動してください。それでもこの状態が変わらない場合は、システム
管理者にお問い合わせください。 

自動サービスを起動すると、トレイアイコン（セクション 4.4.6 を参照）などを使用し
て手動でサービスを停止するまで、有効な状態が保持されます。 
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4.4.5 電子メール通知    

自動機能（「Data readout（データの読み出し）」など）の実行時にエラーが発生した
場合、分析ソフトウェアでは、設定されているすべての受信者に対して 1 回限りの電子
メール通知を送信します。 

テキストベースの電子メールの件名行には、一般情報として「Automatic function 
failed（自動機能が失敗しました）」と表示されます。電子メールの本文には、具体的
なエラーメッセージとその原因および対処法が記載されます。 

これは、電子メールが正しく送信されたかどうかに関係なく、ログファイルに記録され
ます。 

分析ソフトウェアでは、電子メールが正しく配信されたかどうかは検証されません。 
これは上位のメールシステムでしか実行できません。 

 

4.4.6 トレイアイコン   

「トレイアイコンアプリケーション」は、システムのスタートアップ時に自動的に起動し

ます。このアプリケーションが起動すると、トレイアイコン  が Windows メニュープ
ログラムに表示されます。 
アイコンを右クリックすると、次のようなローカルメニューが表示されます。 

 

自動処理が実行状態になると、即座にトレイアイコンが  に変化します。自動サービ
スが有効であり、処理が実行されていない場合は、初期設定のアイコンが表示されます。 

 

Reporting Software（レポート生成ソフト）： 
この最初の項目には、レポート生成ソフトウェアの起動/終了を切り替えるためのサブ項
目が含まれます。 
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自動： 

 
 
横に表示される項目で自動機能の有効/無効を切り替えることができます。「Extras -> 
Settings -> Automatic（その他 -> 設定 -> 自動）」で Windows サービスを起動した場合
にのみ、有効化が可能になります（セクション 5.1.6 を参照）。 
定義されているすべての自動機能が Automatic（自動）サブ項目に表示されます。個々
のタスクの有効/無効を手動で設定できます。タスクを無効に設定した場合、次にサービ
スを起動したときに、そのタスクは実行されません。 
トレイアイコンアプリケーションをクリックするたびに、定義されているタスクのビュー
がレポート生成ソフトウェアと同期され、表示が更新されます。 

Log file（ログファイル）： 
システムサービスのすべてのアクティビティを記録した文書化ファイル
（WindowsServiceLog.txt）が表示されます。文書化ファイルは、以下に保存されています。 
Windows 2000/XP：「C:\Documents and settings\All Users\Application 
data\Endress+Hauser\ FieldDataManager」 
Windows VISTA 以降：「C:\ProgramData\Endress+Hauser\FieldDataManager」 

Log off（ログオフ）： 
ユーザー管理が有効な場合、ユーザーはトレイアイコンアプリケーションに対するログ
オンを要求されます。ログオンしないと、その機能を利用できません。ユーザーがログ
オンすると、「Log off（ログオフ）」機能を使用して再びログオフするまで、その他の
チェックは行われません。トレイアイコンへのログオンは、レポート生成ソフトウェア
へのログオンとは無関係です。 

Exit（終了）： 
トレイアイコンウィンドウを閉じます。ただし、システムサービスには影響を与えません。 

トレイアイコンが自動的に起動しないように設定する場合は、「Extras -> Settings -> 
Automatic（その他 -> 設定 -> 自動）」でこれを無効にすることができます（セクション 
5.1.6 を参照）。レポート生成ソフトウェアでユーザー管理が有効な場合、事前にユーザー
コードを入力する必要があります。 
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4.5 データ管理 -> 設定のインポート/エクスポート   

以下の FDM 設定を保存（エクスポート）し、必要に応じて、再び読み込む（インポート
する）ことができます。 

• テンプレート設定 

• ユーザー設定 

• ユーザー管理設定 

• FDM 設定 

• Codemeter 設定 

• データベース設定 

• 自動設定 

• 機器設定 

エクスポートを実行すると、それと同時に設定用のすべてのファイルが作成され、圧縮
されて、*.settings の形式で保存されるため、改ざんを防止できます。圧縮ファイルの
ファイル名と保存場所は、任意に選択できます。 

 

4.5.1 Data Management -> Export Settings（データ管理 -> 設定のエクスポート） 

設定をエクスポートするには、「Data Management -> Export Settings（データ管理 –> 
エクスポート）」でエクスポート機能を使用します。エクスポートは、3 つの手順で行
います。 

4.5.1.1 Step 1/3：エクスポート形式の選択 

 
「Next（次へ）」ボタンまたはツールバーの緑色の矢印を押すと、次の手順に移動します。 
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4.5.1.2 Step 2/3：ファイル名の選択  

Output File（ファイル出力）： 
File name（ファイル名）：ここではファイル名と保存場所を指定できます。 
「...」ボタンをクリックすると、コンピュータのディレクトリ構造が表示され、エクス
ポート用の保存場所を選択できます。例：
D:\Users\I00400102\Documents\ExportFile.zip 

 
「Next（次へ）」ボタンまたはツールバーの緑色の矢印を押すと、次の手順に移動し、
エクスポートが開始されます。 

 

4.5.1.3 Step 3/3：データのエクスポート  

進捗バーに進捗状況が % 単位で示され、推定の残り時間が表示されます。 

データのエクスポートが正常に完了すると、進捗バーの下に確認メッセージが表示され
ます。 

 

 
「Close（閉じる）」を押すと、プロセスが終了してウィンドウが閉じます。 
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個々の *.settings ファイルは、次のように ZIP ファイルの内部にアーカイブされます。 

 
 

4.5.2 Data Management -> Import Settings（データ管理 -> 設定のインポート） 

*.ZIP ファイルを選択すると、すべての設定をまとめてインポートできます。あるいは、
*.settings ファイルを選択して個別に設定をインポートすることもできます。これを行う
には、ZIP ファイルを解凍する必要があります。 

 

 
• インポートファイルは CRC チェックサムを使用して検証されます。 

• インポートプロセスが完了しなかった場合、ファイルはまったくインポートされません。 

• レポートは、インポートの終了時に表示されます（ステータス、変更、エラーなど）。 

• 同一データを 2 回インポートすることはできません（下記のサンプルレポートを参照）。 

• ユーザー管理が有効な場合、管理者のみがエクスポート/インポートを実行できます。 

• 一部の設定を適用する場合、FDM を再起動する必要があります。 

手順 1/2：ソースの選択 「Select File（ファイルの選択）」ボックスでは、データの保存
場所を選択できます。 
「...」ボタンをクリックすると、コンピュータのディレクトリ構造が表示され、イン
ポートするファイル（*.zip または *.settings）を選択できます。例：
D:\Users\I00400102\Documents\ExportFile.zip 

 

 
「Next（次へ）」ボタンまたはツールバーの緑色の矢印を押すと、次の手順に移動し、
インポートが開始されます。 
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手順 2/2：設定のインポート 進捗バーに進捗状況が % 単位で示され、推定の残り時間が
表示されます。 

データのインポートが正常に完了すると、進捗バーの下に確認メッセージが表示されます。 

 
「Close（閉じる）」を押すと、プロセスが終了してウィンドウが閉じます。 
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5. Extras（その他）メニュー 

5.1 Extras -> Settings（その他 -> 設定） 

ここでは、データベース、言語、エクスポート形式、ユーザー管理の全般的な設定を行
うことができます。 

5.1.1 Language（言語）   

ドロップダウンメニューを使用して、レポート生成ソフトウェアで使用可能な言語を選
択できます。 

言語の設定を変更した場合、ソフトウェアを再起動するまで、その変更は適用されません。 
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5.1.2 Database（データベース）  
データベースの設定では、使用するデータベースまたは対応する SQL サーバーを選択で
きます。 
ダイアログウィンドウの下部セクションにあるボックスを使用して、詳細なユーザー定
義設定を行うことができます。ここでは、既存のデータベースのサーバー名とポート番
号を割り当てて、自動接続解除用のタイムアウトを設定できます。 
既存の SQL Server データベースに、特定のユーザー名とパスワードが必要な場合、ここ
でその情報も入力できます。 

 

 
エッセンシャルバージョンでは、PostgreSQL™ データベースのみがサポートされています。 
エッセンシャルバージョンの使用時には、ネットワーク内に保存されているデータベー
スに対して、複数の PC から同時にアクセスすることはできません。 

 

5.1.3 Export（エクスポート） 
エクスポート形式を設定します。詳細については、セクション 4.2「Data Management -
> Export（データ管理 -> エクスポート）」を参照してください。 
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5.1.4 User administration（ユーザー管理）   

不正な操作からユニットを保護する必要がある場合は、ユーザー管理を使用してセキュ
リティシステムを有効にしてください。レポート生成ソフトウェアの初期インストール
後の初期設定では、ユーザー管理機能が無効になっています。 

ユーザー管理の基本設定は、「Extras –> Settings –> User Administration（その他 –> 設
定 –> ユーザー管理）」メニューで行うことができます。 

 
この設定で、ユーザー管理を有効にすることができます。有効にした場合、最初のユー
ザーに管理者の役割が自動的に割り当てられます。 

ユーザー管理の有効化に加え、パスワードの利用に関連した要件を定義できます。 

より厳格な文書化/セキュリティ要件が規定された FDA21 CFR Part 11 に準拠するには、
この機能も有効にする必要があります。 
この機能を有効にすると、ユーザーはデータベースに影響を与える処理（テンプレート
の作成、機器/機器設定の作成/変更、機器の削除など）を実行するたびに、ユーザー ID 
とパスワードを使用して本人認証を行う必要があります。 

ユーザーの管理は、「Extras –> User Administration（その他 –> ユーザー管理）」で行
います（セクション 5.3 を参照）。 

 
ユーザー管理機能は、プロフェッショナルバージョンとデモバージョンでのみ使用でき
ます。 

 
 

FDM バージョン 1.6 以降は、LDAP プロトコルを介した MS Active Directory とのパス
ワードの同期が使用できます（5.4 章を参照）。 
LDAP を介してパスワードの同期を実行すると、FDA 機能を選択できなくなります。そ
の場合は、必要に応じて、FDA に準拠した認証を Active Directory に実装しなければな
りません。 
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5.1.5 Printer（プリンタ）  
印刷形式は「Printer（プリンタ）」メニューで指定します。プリントアウトにロゴを表
記する場合は、これを選択して「Change Logo（ロゴの変更）」ボタンを使用して設定
できます。 

ドロップダウンリストを使用してフォントを指定できます。 

 
 

（視覚化などにおいて）レポート生成ソフトウェアでプリンタアイコン  をクリック
すると、以下のメニューが表示されます。 

 
ここで必要なプリンタ、印刷レイアウト、印刷設定を選択できます。印刷プレビューも
表示できます。 
  
視覚化用のプリンタ設定では、行ベースまたは列ベースの印刷を選択できます。標準で
は列ベースのレイアウトが有効になっています。行ベースのレイアウトは、分析データ
を含むテンプレートの場合にのみ有効になります。 
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5.1.6 Automatic（自動）  

 
ユーザー管理を有効にした場合、管理者がこれらの自動タスクの設定を変更するために
は、ログオンする必要があります。 

5.1.6.1 Windows システムサービス 

「Automatic（自動）」メニューには、Windows システムサービスとトレイアイコンア
プリケーションの起動/停止機能が含まれます。さらに、ここではこれらの機能を自動的
に起動するかどうかを指定することもできます。 

 
 

Network login identity（ネットワークログイン ID）： 
自動機能を使用して、リモートコンピュータにログオンしてディレクトリにアクセスす
るには、ユーザー名とパスワードが必要です。このユーザーには、選択されたディレク
トリに対する適切な権限が必要となります。 

 
自動機能でネットワークドライブにアクセスできるようにするには、以下の手順を実行
して、自動サービス用のログオン情報を変更する必要があります。 
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1.「Endress+Hauser FDM Service」を開きます：コントロールパネル -> システムとセ
キュリティ -> 管理ツール -> サービス ->「Endress+Hauser FDM Service」をダブルク
リックします。 

 
 

2. 「ログオン」に切り替えます。「This account（このアカウント）」で適切な権限を持
つユーザーを作成します。 

 
「適用」および「OK」をクリックして設定を保存します。 

3. 新しい設定を有効にするには、サービスを再起動する必要があります。 
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データサーバーの設定 
機器のオンラインデータ用のデータサーバー接続は、分析ソフトウェアで設定します。
ホスト名は、自動サービスを実行しているコンピュータと同じです。 

ポート：ポートは「8007」に事前設定されています。これを変更すると、自動的にデー
タサーバーに適用されます。 

5.1.6.2 電子メール設定 

必要に応じて、メール機能の有効/無効を切り替えることができます。標準ではメール機
能は無効になっています。電子メールが正しく送信されるようにするには、以下の設定
を行う必要があります。 

Receivers（受信者）： 
最大 10 個の受信アドレスを入力できます。各電子メールアドレスはセミコロン（;）で
区切ります。 

SMTP Server（SMTP サーバー）/Port（ポート）： 
使用する SMTP サーバーおよびポートを入力します。 

Sender（送信者）： 
送信メール用の名前または電子メールアドレス（通知メールの送信者）。 

Authentication（認証）： 
「自動検出」、「認証なし」、「PLAIN 認証」、「ログイン認証」から認証方法を選択
できます。認証機構が選択された場合は、ユーザーがユーザー名とパスワードを入力す
る必要があります。 

 
送信者設定について不明な点がございましたら、必要に応じてお客様のネットワーク管
理者または電子メールプロバイダにお問い合わせください。 

メール機能を検証して有効化するには、最初に「Send test e-mail（テストメールの送
信）」ボタンを押してテストメールを送信する必要があります。 

「OK」を使用して入力項目を適用するには、テストメールを正常に送信する必要があります。 
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5.1.7 General（一般） 

一般メニュー項目では、拡張サービス機能を使用した読出しを有効化できます。これを
有効にすると、読出しメニューにオプション付きのフィールドが表示され、データの読
出しが正常に完了した後に機器からデータを削除しないことを選択できます。 

 
 

 

5.1.8 ライセンスサーバー設定 

中央ライセンスサーバーの使用は、マルチユーザーライセンスの正常なアクティベーショ
ンの後、共有データベース経由でその他の設定を行うことなく、一元管理されます。 
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5.2 Extras –> Audit trail（その他 –> 監査証跡） 

完全な文書化を実現するために、監査証跡機能では、レポート生成ソフトウェアおよび
対応するデータベース上で実行されたすべての処理が表示されます。 

データベースに影響を与えるすべての処理が、タイムスタンプおよびユーザー名と一緒に
監査証跡に記録されます（ユーザー管理機能が有効な場合）。これには、次のような機能
が含まれます：新しい機器の作成、データの読出し、テンプレートの作成、ユーザーのロ
グイン、ユーザーのログアウト、レポートの生成など。 

監査証跡では、フィルタ（時間、テキスト、ユーザー、カテゴリ）を使用して特定の項
目を検索できます。 

プリンタアイコン  を使用すると、監査証跡を印刷できます。 

 アイコンを使用すると、監査証跡を PDF ファイルとしてエクスポートできます。 
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5.3 Extras -> User administration（その他 –> ユーザー管理） 

 
ユーザー管理機能は、プロフェッショナルバージョンとデモバージョンでのみ使用でき
ます。 

ユーザーの管理は、「Extras -> User administration（その他 –> ユーザー管理）」で行
います。このメニュー項目には、管理者のみがアクセスできます。管理者は最大 50 個
のユーザーを作成できます。ユーザーを作成すると、左側のボックスの概要にそのユー
ザーが表示されます。 

 
ユーザーの作成： 

「プラス記号付きの人物」のアイコン  を使用すると、新規ユーザーを追加できます。 

User ID（ユーザーID）：管理者は、ユーザーごとに一意のユーザー ID を割り当てる必要
があります。これは最大 8 文字です。 

Password（パスワード）、Confirm password（パスワードの確認）：管理者は、ユーザー
の初回ログイン用のパスワードを割り当てる必要があります。これは最大 10 文字です。 

「Password Must be Changed after First Login（最初のログイン後にパスワードを変
更）」機能を選択した場合、新規ユーザーは、自分に割り当てられている最初のパス
ワードを変更する必要があります。 
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ユーザーは、初回ログイン時に管理者が割り当てたパスワードを入力し、新しいパス
ワードを割り当てる必要があります。 

 

Access role（アクセスロール）：さまざまなアクセスの役割をユーザーに割り当てるこ
とができます。これにより、ユーザーのアクセス範囲とアクセス権限が決定されます。 
以下の表は、各ユーザーの役割に対する権限の概要を示します。 

 
アクセスロールと 
アクセス権限 
責任 

アドミニス
トレーター 

サービス 
エンジニア 

プランニング
エンジニア 

メンテナンス 
エンジニア 

システム 
オペレーター 

オブザーバー 

新しいサイトの作成 X  X    

新しいエリア、ユニット
の作成 

X  X    

新しい機器の作成 X  X X X  

サイトおよび機器の移動 X  X    

機器の名前を変更 X  X X   

FieldCare CSV からサイト
をインポート 

X  X    

データの読み出し X  X X X  

データのエクスポート X  X X   

データのインポート X  X X   

改ざん防止データの 
インポート 

X  X X X  

改ざん防止データの 
エクスポート 

X  X X   

可視化、印刷、 
PDF 出力、CSV 出力 

X  X X X X 

自動機能の作成、変更、
削除 

X  X X   

自動機能の開始/停止 X  X X X  

選択、データのマージ X  X X   

データの削除 X  X X   

言語の変更 X X X X X X 

エクスポート設定の変更 X  X X   

パスワード設定 X      

ユーザー管理 X      

監査証跡ビュー X X     
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ユーザーの編集： 

「人物とペン」のアイコン  を使用すると、ユーザーに関する情報を変更し、パス
ワードをリセットできます。ユーザー情報を変更するダイアログの設定は、新規ユー
ザー作成用の設定と同じです。 

 
「Deactivate user（ユーザーの無効化）」機能を使用すると、ユーザーを一時的に無効
化できます。この場合、「ロックされました」というロックアイコンがユーザーの概要
に表示されます。 

ユーザーがログイン時に間違った情報を複数回入力した場合、そのユーザーもロックさ
れているユーザーとして表示されます。管理者はパスワードをリセットすることで、そ
のロックを解除できます。その後、ユーザーはパスワードを再度変更できます。 

ユーザーの削除： 

「赤色の X マーク付きの人物」のアイコン  を使用すると、リストで選択したユー
ザーを削除できます。ユーザーが削除される前に、ダイアログウィンドウに確認メッ
セージが表示されます。ユーザーの削除を確定すると、対応するアカウントが即座に
削除されます。 

プラント設備用のユーザー権限： 

ユーザーの役割の割当ての他に、追加の機器やプラント設備へのアクセスを制限できます。
機器およびプラント設備用のユーザー権限の割当ては、右側のボックスの概要で行います。
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リスト内のユーザーを選択することで、このユーザーに対して、個々の機器とプラント
設備への所定のアクセス権限を付与できます。これを行う場合、管理者はノードを選択
します。これにより、対応するノード（Site、Area など）とそれに割り当てられている
すべてのサブノードへのアクセス権限がユーザーに与えられます。 

ユーザーに特定のプラント設備または機器へのアクセス権限が付与されていない場合
（ノードが選択されていない場合）、プラントビューでは、これらのプラント設備また
は機器は、そのユーザーには表示されません。 

 

テンプレートへのアクセス権限： 
テンプレートへのアクセス権限は、対応する機器によって定義されます。ユーザーがテ
ンプレートにアクセスできるのは、そのユーザーが対応する機器へのアクセス権限を持
つ場合のみです。 

機器へのアクセス権限： 
機器へのアクセス権限は、ユーザー管理機能のプラントビューを使用して定義します。
ユーザーが初めて機器を作成して読出しを行う場合、読出しを実行するユーザーが、こ
の機器へのアクセス権限を自動的に取得します。 

ユーザーとしてログイン： 
ユーザーは、ユーザー ID とパスワードを使用してログインします。これらの大文字と小
文字は区別されます。ユーザーは、初回ログイン時に管理者が割り当てたパスワードを
入力し、必要に応じて新しいパスワードを割り当てる必要があります。ログオンするた
びに、それが成功しても失敗しても関係なく、レポート生成ソフトウェアの監査証跡に
項目が生成されます。 

ユーザーとしてログアウト： 
ユーザーは、以下のさまざまな方法でログアウトできます。 

- レポート生成ソフトウェアの終了 

- 「File -> Logout（ファイル -> ログアウト）」の選択 

- 「File -> Login under another user name...（ファイル -> 別のユーザー名でログイ
ン...）」の選択 

ログアウトするたびに、それが成功しても失敗しても関係なく、ソフトウェアの監査証
跡に項目が生成されます。 
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5.4 ディレクトリサービスサポート用の LDAP プロトコル（MS Active 
Directory）   

FDM は、時には多くのユーザーアカウントで、生産環境やラボ環境で使用されます。これ
らのアカウントの管理は、管理者にとって少なくない負担となります。ここで、よく使用
されるのが、ディレクトリサービスの Microsoft Active Directory です。FDM バージョン 
1.6 以降、LDAP を介したアカウントの同期がサポートされ、ログイン時のパスワード検証
が行われます。LDAP（Lightweight Directory Access Protocol）は、FDM と Microsoft Active 
Directory 間の通信に使用されるオープンなクロスプラットフォームプロトコルです。 

 

LDAP を介したユーザー認証の設定： 

 
 

sAMAccountName  

sAMAccountName 属性は、旧バージョンの Windows のクライアントとサーバーをサポー
トするために使用されるログイン名です。ログイン名は 20 文字以下で、ドメイン内にあ
るすべてのセキュリティプリンシパルオブジェクトの中で一意でなければなりません。 

 

 
LDAP 機能を使用するための詳細設定は、本説明書には記載されていません。これにつ
いては、お客様の IT 部門にお問い合わせください。 
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5.4.1 LDAP を介したユーザーと Active Directory の同期 

LDAP を介した Active Directory へのインターフェイスを設定した後、そこで作成された
アカウントを FDM と同期する必要があります。そのためには、「Extras -> User 
administration（その他 -> ユーザー管理）」を使用してユーザー管理を開きます。
「Synchronize Users（ユーザーの同期）」ボタンにより、FDM と Active Directory のユー
ザー（ユーザー ID とユーザー名）が同期されます。最初の同期時または新しいアカウン
トの作成時に、ユーザーの役割を手動で設定または編集する必要があります。ここで、
FDA に準拠する役割を再びユーザーに割り当てることができます。 
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6. 機器の設定ダイアログ 

設定メニューを使用すると、機器に直接割り当てられる設定を定義できます。これを
行うには、タスクペインの「Data Management -> Plant View（データ管理 -> プラン

トビュー）」で、対応する機器を選択してから、「レンチ」アイコン  をクリック
するか、または右クリックで表示されるコンテキストメニューから「Change 
Settings ...（設定変更...）」を選択して、設定ウィンドウを開きます。 
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6.1 Communication Settings（通信設定）  

機器の通信設定は、初回の読出しプロセス時に定義されます。設定メニューでは、定義
済みの通信設定を変更できます。 

通信設定は、選択する通信タイプおよび接続するフィールド機器に応じて異なります。 
最初の手順では、上部の「Select Source（ソースの選択）」領域でフィールド機器との通
信タイプを選択します。機器タイプは、プラントビューでの機器の選択によってデフォ
ルトで定義されます。 

通信タイプの選択後、下部領域で通信パラメータを定義します。 
通信設定を確定して保存するには、「OK」ボタンを使用してメニューを終了する必要が
あります。 

 

通信タイプと通信設定： 

シリアル通信：シリアル通信（RS232/485 など）の場合、規定のパラメータを設定します。 

「Automatic（自動）」：使用可能なすべてのシリアルインターフェイスがスキャンされ、
接続機器および必要な通信設定が自動的に検出されます。 

「Manual（手動）」：通信パラメータを手動で定義して、規定のフィールドに入力します。 
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Modem（モデム）：通信パラメータを規定のフィールドに入力します。これは、モデム
の関連資料および無線プロバイダから提供される場合があります。 

 
 

Ethernet：イーサネット通信パラメータを規定のフィールドに手動で入力します。ポー
ト番号などの詳細情報については、システム管理者にお問い合わせください。 
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USB：通常、デフォルトの USB 設定をそのまま使用できます。必要に応じて、「Device 
Address（機器アドレス）」および「Readout ID（ID の読み出し）」パラメータを手動で
変更してください。 

 
 

6.2 Database information（データベース情報）  
機器ダイアログのデータベース情報には、機器から読み出されてデータベースにインポー
トされた機器データとデータ容量に関する情報が表示されます。 

 
Name（名前）：機器名  

Firmware version（ファームウェアのバージョン）：機器のファームウェアバージョン 

Order code（注文コード）：注文/納入オプションを使用して機器を識別します。 

Order identifier（注文の識別子）：機器、注文、顧客を識別する番号 

Database size（データベースのサイズ）：SQL データベースに保存されている機器デー
タのサイズ 

Endress+Hauser W@M ポータルからオーダーコードとオーダー ID を使用して、その他
の機器情報にアクセスできます。これはプラントのライフサイクル全体にわたる機器管
理に関する情報です。 
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6.3 Automatic – Read out device（自動 – 機器の読出し）   

機器読出しの自動機能は、設定メニューで有効/無効を切り替えます。 

 
（詳細については、セクション 4.4「Data Management –> Automatic（データ管理 –> 自
動）」を参照） 

 

Active（有効）：「Data Readout（データ読み出し）」自動機能の有効/無効を切り替え
ます。 

Interval（間隔）：この自動機能の周期を選択します。 
オプション：Minutely（1 分毎）、Hourly（1 時間毎）、Dairy（毎日）、Weekly（毎
週）、Monthly（毎月） 

Repeat every（すべて繰り返し）（間隔で 1 分毎または 1 時間毎を選択した場合のみ）：
選択した周期の自動機能のタイムラグを選択します。 

Start day（開始日）（間隔で毎週または毎月を選択した場合のみ）：選択した周期の自
動機能の曜日を選択します。 

Start time（開始時間）（間隔で毎日、毎週、または毎月を選択した場合のみ）：選択し
た周期の自動機能の開始時刻を選択します。 

Additional batch triggered（追加のバッチが発生しました）： 
次の自動機能に対してのみ選択できます：機器の読み出し、テンプレートを印刷、
XLX/CSV エクスポート、PDF 出力（バッチデータが使用可能な場合）。 
バッチジョブが完了すると、即座に自動機能が実行されます。 
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6.4 Automatic – Delete data（自動 – データ削除）  

 
データの削除後に、これを取り消すことはできません。機器からデータを削除する場合、
そのデータが本当に不要であるかどうかを確認してください。あるいは、必要に応じて
データを後から利用できるように、データを保護付きエクスポートで別の保存場所に保
存しておいてください。 

データ削除の自動機能は、設定メニューで有効/無効を切り替えます。 

 
Active（有効）：「Data Elimination（データ消去）」自動機能の有効/無効を切り替えます。 

Interval（間隔）：この自動機能の周期を選択します。 
オプション：Minutely（1 分毎）、Hourly（1 時間毎）、Dairy（毎日）、Weekly（毎
週）、Monthly（毎月） 

Repeat every（すべて繰り返し）（間隔で 1 分毎または 1 時間毎を選択した場合のみ）：
選択した周期の自動機能のタイムラグを選択します。 

Start day（開始日）（間隔で毎週または毎月を選択した場合のみ）：選択した周期の自
動機能の曜日を選択します。 

Start time（開始時間）（間隔で毎日、毎週、または毎月を選択した場合のみ）：選択し
た周期の自動機能の開始時刻を選択します。 

Time slot（タイムスロット）：データ削除のタイムスロットを選択します。設定された
時間のデータは削除されません。 

例： 
Interval: Daily; start time: 23:59:00; time slot: 0 day 00:09:00 
データは毎日 23:59 に削除されます。最後の 9 分間のデータはメモリに保持されます。 
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6.5 Automatic – Time synchronize（自動 – 時刻の同期）  

ここでは機器の時刻とコンピュータのシステム時間を自動的に同期させることができま
す。時刻同期の自動機能は、設定メニューで有効/無効を切り替えます。 

 
Active（有効）：「Time Synchronize（時刻の同期）」自動機能の有効/無効を切り替え
ます。 

Interval（間隔）：この自動機能の周期を選択します。 
 

周期として指定できるオプションは機器ごとに異なります。 

Repeat every（すべて繰り返し）（間隔で 1 分毎または 1 時間毎を選択した場合のみ）：
選択した周期の自動機能のタイムラグを選択します。 

Start day（開始日）（間隔で毎週または毎月を選択した場合のみ）：選択した周期の自
動機能の曜日を選択します。 

Start time（開始時間）（間隔で毎日、毎週、または毎月を選択した場合のみ）：選択し
た周期の自動機能の開始時刻を選択します。 

Tolerance（許容範囲）：時刻同期の許容誤差を選択します。機器とコンピュータの各シ
ステム時間に、ここで設定した許容誤差を超える差がある場合、時刻は同期されません。 
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6.6 Automatic – Binary export（自動 – バイナリ出力）  

データバックアップの自動機能は、設定メニューで有効/無効を切り替えます。 

 
Active（有効）：「Data Backup（データバックアップ）」自動機能の有効/無効を切り
替えます。 

Interval（間隔）：この自動機能の周期を選択します。 
オプション：Minutely（1 分毎）、Hourly（1 時間毎）、Dairy（毎日）、Weekly（毎
週）、Monthly（毎月） 

Repeat every（すべて繰り返し）（間隔で 1 分毎または 1 時間毎を選択した場合のみ）：
選択した周期の自動機能のタイムラグを選択します。 

Start day（開始日）（間隔で毎週または毎月を選択した場合のみ）：選択した周期の自
動機能の曜日を選択します。 

Start time（開始時間）（間隔で毎日、毎週、または毎月を選択した場合のみ）：選択し
た周期の自動機能の開始時刻を選択します。 

Data time period（データの時間範囲）：バックアップするデータの期間を選択します 
（例：「0 day 10:00:00」を選択した場合、最後の 10 時間のデータが保存されます）。 

File path（ファイルパス）：ここではファイルの保存場所を指定します。「...」ボタン
をクリックすると、コンピュータのディレクトリ構造が表示され、保存場所を選択でき
ます。 
ネットワークドライブを選択した場合は、ユーザー名とパスワードの入力も求められま
す。その設定は保存され、「Extras -> Settings -> Automatic（その他 -> 設定 -> 自
動）」で変更できます（セクション 5.1.6 を参照）。 

 

 
データのバックアップコピーを作成するたびに、新しいファイルが作成されます。ファ
イル名には、形式が「年-月-日 時-分-秒」のタイムスタンプが自動的に付加されます 
（例：automatic_test_ 2010-06-25 08-09-30.fdm）。 
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6.7 Automatic – Certification PDF export（自動 – 認証 PDF 出力）  

この機能を使用すると、Memograph M RSG45 システム（TrustSens 校正監視）に記録さ
れている iTHERM TrustSens 校正証明書を一定の周期で自動的に PDF ファイルとしてエ
クスポートできます。 
 

 
Active（有効）：PDF 証明書エクスポートの自動機能の有効/無効を切り替えます。 

Interval（間隔）：この自動機能の周期を選択します。 

オプション：Every minute（1 分毎）、hour（1 時間毎）、day（毎日）、week（毎週）、
month（毎月） 

Repeat every（すべて繰り返し）（間隔で 1 分毎または 1 時間毎を選択した場合のみ）：
選択した周期の自動機能のタイムラグを選択します。 

Start day（開始日）間隔で毎日、毎週または毎月を選択した場合のみ）：選択した周期
の自動機能の曜日を選択します。 

Start time（開始時間）（間隔で毎日、毎週または毎月を選択した場合のみ）：選択した
周期の自動機能の開始時刻を選択します。 

Export path（エクスポートパス）：ここには保存場所を指定します。「...」ボタンをク
リックすると、コンピュータのメニュー構造が表示され、保存場所を選択できます。 

Export folder（エクスポートフォルダ）：このオプションを選択した場合、TrustSens 機
器ごとに個別のフォルダが自動的に作成されます（例：EH_TM371_N3044B04487）。 

Time stamp（タイムスタンプ）： 
このオプションを選択した場合、ファイル名の最後にタイムスタンプが自動的に付加さ
れます。 
ファイル名の例：「N3044B04487-0-19_20190124-140934.pdf」 
「N3044B04487」：TrustSens のシリアル番号 
「0_19」：校正番号 
「20190124」：日付（形式「年-月-日」） 
「140934」：時刻（形式「h-m-s」） 
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7. トラブルシューティング 

7.1 システムエラーメッセージ 

データ読出中のエラーメッセージ： 
 

エラーコード 問題、原因 対処法 
0x20000001 データ読出中に内部エラーが発生しました。 もう一度お試しください。 
0x20000002 ファイルにアクセスできません。 ファイルパスを確認してください。 
0x20000003 データにアクセスできません。 アクセス権限を確認してください。 
0x20000004 機器への接続時にエラーが発生しました。 もう一度お試しください。 
0x20000005 機器との通信時にエラーが発生しました。 もう一度お試しください。 
0x20000006 通信設定が正しくありません。 設定を確認してください。 
0x20000007 機器との通信時にエラーが発生しました。 もう一度お試しください。 
0x20000008 機器との通信時にエラーが発生しました。 もう一度お試しください。 
0x20000009 機器との通信時にエラーが発生しました。 もう一度お試しください。 
0x2000000A レポート生成ソフトウェアが接続機器をサポートしていま

せん。 
別のディレクトリを選択してください。 

0x2000000B 機器との通信時にエラーが発生しました。 もう一度お試しください。 
0x2000000C 設定されている機器アドレスが正しくありません。 設定を確認してください。 
0x2000000D 機器への接続が遮断されました。 もう一度お試しください。 
0x2000000E インターフェイスで機器が検出されませんでした。 接続とインターフェイス設定を確認してください。 
0x2000000F 機器との通信時にエラーが発生しました。 もう一度お試しください。 
0x20000010 指定された IP アドレスまたはホストを検出できませんで

した。 
設定を確認してください。 

0x20000011 指定された COM ポートが他のアプリケーションで使用中
です。 

接続設定を確認してください。 

0x20000012 COM ポートが存在しません。 接続設定を確認してください。 
0x20000013 データが破損しているため、読み取ることができません。 サポートにご連絡ください。 
0x20000014 指定されたパスを検出できません。 ファイルパスを確認してください。 
0x20000015 指定された時間範囲に取得できるデータがありません。 別の時間範囲を選択してください。 
0x20000016 不明な機器タイプのデータであり、読み取ることができま

せん。 
サポートにご連絡ください。 

0x20000017 接続されたモデムを初期化できませんでした。 モデムの接続を確認して、もう一度お試しください。 
0x20000018 接続されたモデムが応答しません。 接続と設定を確認してください。 
0x20000019 一般的なモデムエラー。 もう一度お試しください。 
0x2000001A 利用可能な通信チャンネルがすべて使用中のため、現在、

機器にアクセスすることができません。 
もう一度お試しください。 

0x20000020 機器はすでにアクセス中です。 手動および自動の設定を確認してください。 
0x20000021 利用可能な他の機器データが存在しません。 あとでもう一度お試しください。 
0x20000022 機器はすでにアクセス中です。 手動および自動の設定を確認してください。 
0x20000023 機器の時刻更新エラー。時刻同期の制約の可能性があり

ます。 
あとでもう一度お試しください。 

0x20000024 他の機器が検出されました。 指定された機器タイプを確認してください。 
0x20000025 互換性のないファイル形式が検出されました。 レポート生成ソフトウェアをアップデートしてくだ

さい。 
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自動サービスに関連したエラーメッセージ： 
 

エラーコード 問題、原因 対処法 

0x40000000 
レポート生成ソフトウェアの自動サービスおよびトレイアイ
コンアプリケーションがインストールされていません。 

自動コンポーネントをインストールしてください。 

0x40000001 レポート生成ソフトウェアの自動サービスが停止しています。 自動サービスを開始してください。 
0x40000002 自動サービスでエラーが発生しました。 自動設定を確認してください。 
0x40000003 機器の読出時にエラーが発生しました。 自動設定を確認してください。 
0x40000004 送信データの保存時にエラーが発生しました。 自動設定を確認してください。 
0x40000005 データの自動削除時にエラーが発生しました。 自動設定を確認してください。 
0x40000006 サービスとトレイアイコン間の通信を確立できません。 サポートにご連絡ください。 

0x40000007 
バイナリ形式でのデータの自動エクスポート時にエラーが発
生しました。 

自動設定を確認してください。 

0x40000008 
XLS または CSV 形式でのデータの自動エクスポート時にエ
ラーが発生しました。 

自動設定を確認してください。 

 
データベースアクセスでのエラーメッセージ： 
 

エラーコード 問題、原因 対処法 
0x60000000 データベースへのアクセス時にエラーが発生しました。 データベース設定とデータベースが使用可能かどう

かを確認してください。 
0x60000001 データベースアクセス時のエラー。 データベース設定とデータベースが使用可能かどう

かを確認してください。 

 
ユーザー管理に関連したエラーメッセージ： 
 

エラーコード 問題、原因 対処法 
0x60010000 管理者によってユーザーアカウントがブロックされました。 管理者にお問い合わせください。 
0x60010001 現在のユーザーが管理者ではありません。この処理を行う

には、管理者権限が必要です 
管理者にお問い合わせください。 

0x60010002 管理者権限が必要です。 管理者にお問い合わせください。 
0x60010003 パスワードは変更されませんでした。新しいパスワードが

承認されませんでした。 
別のパスワードを割り当ててください。 

0x60010004 パスワードの変更に失敗しました。 別のパスワードを割り当ててください。 
0x60010005 ユーザーの削除に失敗しました。 もう一度お試しいただくか、管理者にお問い合わせ

ください。 
0x60010006 管理者が設定されていないため、ユーザー管理を実行でき

ません。 
ユーザー管理機能で管理者を設定してください。 

0x60010007 正しくないパスワードが {0} 回入力された後に、ユーザー
アカウントがブロックされました。 

管理者にお問い合わせください。 

0x60010008 正しくないパスワードが {0} 回入力された後、10 分間、
ユーザーアカウントがブロックされました。 

10 分後にもう一度お試しください。 

0x60010009 ログインに失敗しました。 もう一度お試しください。 
0x60010010 ユーザー ID またはパスワードが正しくありません。 もう一度お試しください。 
0x60010011 パスワードが有効期限切れのため、新しいパスワードが必

要です。 
新しいパスワードを割り当ててください。 

0x60010012 ユーザー管理が有効な場合、すべての管理者を削除するこ
とはできません。 

ユーザー管理を無効にしてください。 

0x60010013 現在ログインしているユーザーを削除することはできません。 別のユーザー名でログインしてこのユーザーを削除
してください。 

0x60010014 ユーザー管理が有効な場合には、少なくとも 1 つの管理者が
常に必要となります。 

ユーザー管理機能で管理者を設定してください。 

0x60010015 新しいパスワードと確認用の新しいパスワードが異なります。 2 つのパスワードをもう一度入力してください。 
0x60010019 新しいパスワードは、直近の {0} 個のパスワードとは異なる

ものにしてください。 
別のパスワードを割り当ててください。 

0x60010020 パスワードは {0} 文字以上にしてください。 別のパスワードを割り当ててください。 
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エラーコード 問題、原因 対処法 
0x60010021 パスワードは 5 文字以上にしてください。 別のパスワードを割り当ててください。 
0x60010022 パスワードには数字を使用する必要があります。 別のパスワードを割り当ててください。 
0x60010023 パスワードには特殊文字を使用する必要があります。 別のパスワードを割り当ててください。 
0x60010024 パスワードには大文字と小文字を使用する必要があります。 別のパスワードを割り当ててください。 
0x60010025 これ以上、ユーザーを作成することはできません。レポート生

成ソフトウェアでは、最大 50 個のユーザーを作成できます。 
古いユーザーアカウントを最初に削除してください。 

0x60010027 このユーザー ID はすでに存在します。 別のユーザー ID を割り当ててください。 
0x60010028 データベースに管理者が作成されていないため、ユーザー

管理を実行できません。 
ユーザー管理機能で管理者を設定してください。 

0x60010032 データベース設定を変更する権限がありません。データ
ベース設定は変更されませんでした。 

管理者にお問い合わせください。 

 
データ読出中のエラーメッセージ： 
 

エラーコード 問題、原因 対処法 

0x60020000 データ保存に失敗しました。次のファイルが破損していま
す：'{0}' 

ファイルを確認して、もう一度お試しください。 

0x60020001 データベースアクセス時のエラー。次のファイルを保存でき
ませんでした：'{0}'。 

もう一度お試しください。 

0x60020002 データ保存に失敗しました。次のファイルを保存できません
でした：'{0}'。 

もう一度お試しください。 

0x60020003 データ読出しに失敗しました。機器に接続できません。 もう一度お試しください。 

0x60020004 データ読出しに失敗しました。現在のユーザーには適切なア
クセス権限がないため、データベースに新しい機器を作成で
きませんでした。次のファイルを保存できませんでした：'{0'} 

アクセス権限を確認してください。 

0x60020005 データ損失が発生するため、設定「{0}」と「{1}」をマー
ジできませんでした。 

別の設定を選択してください。 

0x60020006 設定「{0}」と「{1}」の間で時間が重複しているため、設
定をマージできませんでした。 

別の設定を選択してください。 

0x60020007 データベースサーバーとの接続を確立できません。 設定を確認してください。 
0x60020008 新しい設定を使用してデータベースサーバーに接続できま

せん。データベース設定の変更が適用されていません。 
設定を確認してください。 

0x60020009 無効なデータベース設定 設定を確認してください。 
0x60020010 ファイルの削除に失敗しました。 手動でデータを削除してください。 
0x60020011 読出しが完了したデータを機器から削除できませんでした。 手動でデータを削除してください。 
0x60020012 機器への接続時にエラーが発生しました。 通信接続を確認して、もう一度お試しください。 
0x60020013 機器「{0}」と機器「{1}」が異なる機器タイプであるた

め、機器をマージできませんでした。 
 同じタイプの機器を 2 つ選択してください。 

0x60020014 機器「{0}」は機器「{1}」と時間的に重複しているため、
機器をマージすることができませんでした。 

 時間的に重ならないように 2 つの機器を選択して
ください。 

0x60020015 新しいノードを追加できませんでした。 もう一度お試しください。 
0x60020016 ノードの追加に失敗しました。 もう一度お試しください。 
0x60020017 新しいノードを追加できません。 より権限の高いユーザーロール（例：管理者）でロ

グインしてください。 
0x60020018 ノードの追加 より権限の高いユーザーロール（例：管理者）でロ

グインしてください。 
0x60020019 選択されたノードが削除されない場合があります。 より権限の高いユーザーロール（例：管理者）でロ

グインしてください。 
0x60020020 ノードの削除 より権限の高いユーザーロール（例：管理者）でロ

グインしてください。 
0x60020021 選択されたノードが移動されない場合があります。 より権限の高いユーザーロール（例：管理者）でロ

グインしてください。 
0x60020022 ノードの移動 より権限の高いユーザーロール（例：管理者）でロ

グインしてください。 
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エラーコード 問題、原因 対処法 

0x60020023 選択されたノードの名前が変更されない場合があります。 より権限の高いユーザーロール（例：管理者）でロ
グインしてください。 

0x60020024 ノードの名称変更 より権限の高いユーザーロール（例：管理者）でロ
グインしてください。 

0x60020025 新しいノードを作成できませんでした。 設定を確認してください。 
0x60020026 ノードの作成に失敗しました。 設定を確認してください。 
0x60020027 選択されたノードを削除できませんでした。 設定を確認してください。 
0x60020028 ノードの削除に失敗しました。 設定を確認してください。 
0x60020029 ノードの削除に失敗しました。 もう一度お試しください。データベース接続のタ

イムアウト値を大きくする必要があるかもしれま
せん。 

0x60020030 選択されたノードを削除できませんでした。 もう一度お試しください。データベース接続のタイム
アウト値を大きくする必要があるかもしれません。 

0x60020032 インポート中にエラーが発生しました。{0}/{1} 行がイン
ポートされませんでした。 

 

0x60020034 選択されたノードを移動できませんでした。 設定を確認してください。 
0x60020035 ノードを移動できません。 設定を確認してください。 
0x60020036 ファイル「{0}」を開くことができません。  ファイルが読めるかどうか確認してください。 
0x60020037 プラントビューを更新できませんでした。 設定を確認してください。 
0x60020038 プラントビューの更新に失敗しました。 設定を確認してください。 
0x60020039 テンプレートビューを更新できませんでした。 設定を確認してください。 
0x60020040 テンプレートビューの更新に失敗しました。 設定を確認してください。 
0x60020041 選択されたノードの名前を変更できません。 名前は 30 文字を超えないようにしてください。 
0x60020042 ノード名の変更に失敗しました。 名前は 30 文字を超えないようにしてください。 
0x60020043 通信設定の更新に失敗しました。 設定を確認してください。 
0x60020044 通信設定の更新に失敗しました。 設定を確認してください。 
0x60020045 データベースサーバーとの接続を確立できません。データ

ベーススキームは生成されませんでした。 
管理者にお問い合わせください。 

0x60020046 通信設定が無効です。 「Back（戻る）」を押して、別の設定を選択して
ください。 

0x60020047 設定のマージに失敗しました。 もう一度お試しいただくか、別の設定を選択してく
ださい。 

0x60020048 機器のマージに失敗しました。 もう一度お試しいただくか、別の機器を選択してく
ださい。 

0x60020049 選択された機器の通信設定がありません。 択した機器の通信設定を変更してください。 
0x60020050 データを利用できるファイルがありません。 別のディレクトリを選択してください。 
0x60020051 機器情報の読出時にエラーが発生しました。 接続を確認して、もう一度お試しください。 

 
エクスポート中のエラーメッセージ： 
 

エラーコード 問題、原因 対処法 

0x60030000 エラーにより終了しました。 もう一度お試しください。 
「Close（閉じる）」をクリックしてウィザードを
終了します。 

0x60030001 エラーにより終了しました。 
データがデータベースからエクスポートされましたが、削
除できませんでした。 

「Close（閉じる）」をクリックしてウィザードを
終了します。 

0x60030002 選択された時間範囲では、データベースにデータが存在し
ません。ファイルは生成されませんでした。 

有効な時間範囲を選択してください。 

0x60030003 選択されたテンプレートには、データベースで使用できな
い機器が含まれます。 

テンプレートを削除してください。 

0x60030004 不足している機器 テンプレートを削除してください。 
0x60030005 選択されたテンプレートには、データベースで使用できな

い機器が少なくとも 1 つ含まれます。 
テンプレートを削除してください。 

0x60030006 不足している機器 テンプレートを削除してください。 
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エラーコード 問題、原因 対処法 

0x60030007 選択されたテンプレートはデータベースに存在しません。
削除されたと考えられます。 

別のテンプレートを選択してください。 

0x60030008 テンプレートを使用できません。 別のテンプレートを選択してください。 
0x60030009 このテンプレート内の少なくとも 1 つの機器に対するアク

セス権限がないため、このテンプレートを開くことができ
ません。 

レポート生成ソフトウェアの管理者にお問い合わせ
ください。管理者が必要な権限を割り当てることが
できます。 

0x60030010 アクセス権限がありません。 レポート生成ソフトウェアの管理者にお問い合わせ
ください。管理者が必要な権限を割り当てることが
できます。 

 
インポート中のエラーメッセージ： 
 

エラーコード 問題、原因 対処法 

0x60040000 バイナリファイルが、最新バージョンのレポート生成ソフ
トウェアを使用して保存されているため、インポートでき
ません。 

レポート生成ソフトウェアを現在のバージョンに
アップデートしてください。 

0x60040001 エラーにより終了しました。データはインポートされませ
んでした。 

インポートファイルを確認してください。 
「Close（閉じる）」をクリックしてウィザードを
終了します。 

0x60040002 警告により終了しました。一部のデータをインポートでき
ませんでした。 

「Close（閉じる）」をクリックしてウィザードを
終了します。 

0x60040003 インポートに失敗しました。指定されたインポートファイ
ルにデータがありません。データはインポートされません
でした。 

ファイルを確認してください。 

 
視覚化に関連したエラーメッセージ： 
 

エラーコード 問題、原因 対処法 

0x60050000 テンプレートが保存されていないため、自動変更を保存す
ることができません。 

テンプレートを保存してください。 

0x60050001 テンプレートの保存中にエラーが発生しました。テンプ
レートがデータベースに保存されていません。 

データベースの設定を確認してください。 

0x60050002 テンプレート保存時のエラー。 データベースの設定を確認してください。 
0x60050003 エクスポート中にエラーが発生しました。エクスポートに

失敗しました。 
選択したディレクトリのディスク容量が十分にある
か確認し、このディレクトリへの書き込み権限があ
ることを確認してください。 

0x60050004 「最小」値には「最大」値より小さい値を設定してくだ
さい。 

選択した値を確認してください。 

0x60050005 選択された時間範囲では、データベースにデータが存在し
ません。 

別の時間範囲を選択してください。 

0x60050006 使用可能なデータがありません。 別の時間範囲を選択してください。 
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インストールまたはデータベースに関連したエラーメッセージ： 
 

エラーコード 問題、原因 対処法 

0x60060000 デモバージョンの試用期間が終了しました。今後、このア
プリケーションを起動することはできません。 

完全版のシリアル番号をご注文ください。 

0x60060001 デモバージョンの試用期間が終了しました。今後、このア
プリケーションを起動することはできません。 

完全版のシリアル番号をご注文ください。 

0x60060002 ライセンス情報が正しくありません。 インストールプログラムを再起動してください。 
0x60060003 ライセンス情報が正しくありません。 インストールプログラムを再起動してください。 
0x60060004 新しい言語設定はプログラムの再起動後に有効になります。 レポート生成ソフトウェアを再起動してください。 
0x60060005 新しい言語設定はプログラムの再起動後に有効になります。 レポート生成ソフトウェアを再起動してください。 
0x60060006 現在接続されているデータベースサーバーに有効なデータ

ベースが存在しないか、または使用されているデータベー
スのバージョンが正しくありません。 

管理者にお問い合わせください。 

0x60060007 データベースが正しくありません。 管理者にお問い合わせください。 

 

印刷中のエラーメッセージ： 

 
エラーコード 問題、原因 対処法 

0x60070000 1000 ページ以上のドキュメントが必要です。 この問題を避けるためには、より短い期間を選択し
てください。 

0x60070001 1000 ページを超えた時点で最大ページ数に達したため、ド
キュメント作成を中止しました。 

この問題を避けるためには、より短い期間を選択し
てください。 
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8. TrustSens 校正監視 

 
Memograph M RSG45（ファームウェアバージョン 2.04 以降）および iTHERM TrustSens 
TM371/TM372 を併用する場合に利用できます。 

Memograph M RSG45 アプリケーションパッケージ： 

• HART インターフェイスを介して最大 20 個の iTHERM TrustSens TM371/TM372 温
度計を評価可能  

• 画面上または Web サーバーを介した自己校正データの表示 

• 校正履歴の生成 

• 校正証明書を RTF ファイルとして RSG45 に直接作成  

• 「Field Data Manager」（FDM）分析ソフトウェアを使用した校正データの評価、
分析、さらなる処理 

追加情報：取扱説明書「TrustSens 校正監視」（BA01887R）（英文）を参照してください。 
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9. 索引 

Ａ 
Active Directory, 112 
Audit trail（監査証跡）, 107 
Automatic – Binary export（自動 – バイナリ出力）, 

121 
Automatic – Certification PDF export（自動 – 認証 PDF 
出力）, 122 

Automatic – Delete data（自動 – データ削除）, 119 
Automatic – Read out device（自動 – 機器の読出し）, 

118 
Automatic – Time synchronize（自動 – 時刻の同期）, 

120 
Automatic（自動）, 85, 103 

Ｃ 
Communication Settings（通信設定）, 115 

Ｄ 
Data management -> Export（データ管理 -> エクス
ポート）, 67 

Data management -> Import（データ管理 -> インポー
ト）, 81 

Data management（データ管理）, 61 
Database information（データベース情報）, 117 
Database（データベース）, 100 

Ｅ 
Edit template（テンプレートの編集）, 57 
Export（エクスポート）, 100 
Extras（その他）, 99 

Ｇ 
General（一般）設定, 106 

Ｌ 
Language（言語）, 99 
LDAP プロトコル, 112 
LDAP を介したユーザーと Active Directory の同期, 113 

Ｐ 
Plant view（プラントビュー）, 24, 31, 35, 41, 58, 61 
Printer（プリンタ）, 102 

Ｒ 

Read Out Data（データの読み出し）, 27 

Ｓ 
Settings（設定）, 99 

Ｕ 
User administration（ユーザー管理）, 101, 108 

Ｖ 
Visualization -> New（可視化 -> 新規）, 41 
Visualization -> Open（可視化 -> 開く）, 55 
Visualization（可視化）, 40 

あ 
新しい機器の作成, 35 
安全上の注意事項, 9 

い 
インストール/アンインストール, 14 

え 
エネルギー監視, 73 

お 
オンラインインターフェースの設定, 36 

か 
概要, 9 
可視化 -> 新規, 50 
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き 
機器情報, 38 
機器の設定, 114 
機器の選択, 29, 41, 50, 58, 66 
機器のマージ, 66 

く 
グラフ, 44, 56 

け 
結果 
機器のマージ, 67 

現在値の表示（ライブ表示）, 52 

さ 
作成済みの機器を選択, 31 
サンプラ, 48 

し 
自動設定, 37, 71 
序文, 9 

せ 
設定のインポート/エクスポート, 95 
設定の選択, 64 
設定のマージ, 63 

た 
タイムスロットの選択, 43, 56 

ち 
チャンネル選択, 42, 51, 55, 59 

て 
データソースの選択, 28 

データのエクスポート, 72 
データの読み出し, 34, 39 
データの読み出し -> オンライン接続, 31 
データの読み出し -> マスストレージ, 28 
データ読出し, 30 
電子メール通知, 93 
テンプレートの更新, 60 
テンプレートの使用方法を選択, 74 
テンプレートの選択, 55, 57 

と 
トレイアイコン, 93 

は 
ハードウェア/ソフトウェア要件, 11 
バイナリファイル（*.fdm）のエクスポート, 68 

ひ 
表示形式の選択, 51 

ふ 

プログラム履歴, 48 

ほ 
保護のない形式（Excel/CSV、エネルギー監視用ファイ
ル）でのエクスポート, 73 

ま 
マージ, 65 

め 
免責事項, 10 

ら 
ライセンスサーバー設定, 106 
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